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开发工具客户须知

重要：

开发工具手册如同所有其他文档一样具有时效性。我们不断改进工具和文档以满足客户的需求，

因此实际使用中有些对话框和/或工具说明可能与本文档所述之内容有所不同。请访问我们的网

站（www.microchip.com/）获取最新版本的 PDF 文档。

文档每页的底部均标有 DS 编号。DS 格式为 DS<文档编号><版本>_CN，其中<文档编号>为 8 位

数字，<版本>为大写字母。

有关最新信息，请访问 onlinedocs.microchip.com/查看您所使用的工具的帮助信息。

 MPLAB® ICD 5 在线调试器用户指南
 

https://www.microchip.com/
https://onlinedocs.microchip.com/
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1. 前言
本部分讨论 MPLAB ICD 5 的文档和支持信息。

1.1 本指南使用的约定
本指南采用以下文档约定：

表 1-1. 文档约定

说明 表示 示例

Arial 字体：

斜体字 参考书目 MPLAB® IDE User's Guide

需强调的文字 ...仅有的编译器...

首字母大写 窗口 Output 窗口

对话框 Settings 对话框

菜单选择 选择 File，然后单击 Save。

引用 窗口或对话框中的字段名 “Save project before build”

带右尖括号有下划线的斜体文字 菜单路径 File>Save

粗体字 对话框按钮 单击 OK

选项卡 单击 Power 选项卡

N'Rnnnn verilog 格式的数字，其中 N 为总位数，R 为基数，n
为其中一位。

4'b0010，2'hF1

尖括号< >括起的文字 键盘上的按键 按下<Enter>，<F1>

Courier New 字体：

常规 Courier New 源代码示例 #define START
文件名 autoexec.bat
文件路径 C:\Users\User1\Projects
关键字 static, auto, extern
命令行选项 -Opa+，-Opa-
二进制位值 0和 1
常量 0xFF，‘A’

斜体 Courier New 可变参数 file.o，其中 file可以是任一有效文件名

方括号[ ] 可选参数 xc8 [options] files
花括号和竖线：{ | } 选择互斥参数；“或”选择 errorlevel {0|1}
省略号... 代替重复文字 var_name [, var_name...]

表示由用户提供的代码 void main (void)
{ ...
}

1.2 推荐读物
本文档介绍如何使用 MPLAB® ICD 5 在线调试器。下面列出了其他有用的文档。以下 Microchip 文档均已

提供，并建议读者作为补充参考资料。

开发工具设计忠告

请先阅读本文档！

本文档包含有关在使用 MPLAB® ICD 5 在线调试器进行目标设计时应考虑的操作问题的重要信息。请参见

开发人员帮助中的开发工具设计忠告。

MPLAB X IDE 在线帮助/用户指南

https://microchipdeveloper.com/dtda:start
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这是在使用任何 Microchip 硬件工具时的必备文档。

这是 MPLAB X IDE 的全面帮助文件。它包括嵌入式系统的概述、安装要求、教程以及创建新项目、设置编

译属性、调试代码、设置配置位、设置断点以及编程器件等方面的详细信息。此帮助文件通常比可以从

www.microchip.com/mplabx/免费下载的用户指南（DS50002027）的 PDF 内容更新。

MPLAB® ICD 5 在线调试器的发行说明

有关使用 MPLAB ICD 5 的最新信息，请选择 MPLAB X IDE 工具栏上的 Help > Release Notes（帮助 > 发
行说明）。发行说明包含本用户指南中可能未提供的更新信息和已知问题。

MPLAB® ICD 5 在线调试器快速入门指南宣传页（DS50003240）

该宣传页介绍了如何使用目标板为 MPLAB ICD 5 连接硬件和安装软件。

https://www.microchip.com/mplabx/
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2. 关于调试器
MPLAB® ICD 5 在线调试器/编程器（DV164055）是 Microchip 最新的仿真和编程工具，速度快且功能丰

富，适用于包括 PIC®、dsPIC®、AVR®和 SAM（Arm®）器件在内的 Microchip 单片机（MCU）。可与功能

强大且拥有易于使用的图形用户界面的 MPLAB X 集成开发环境（Integrated Development
Environment，IDE）配合使用，进行调试和编程。

默认情况下，MPLAB ICD 5 通过高速 USB 2.0 接口连接到 PC。此外，也可以使用以太网连接。

MPLAB ICD 5 使用扁平线缆连接到目标板，线缆的一端连接到调试器，另一端连接到目标板。

该调试器与内置仿真电路的器件通信，而非与特殊调试器芯片通信，因此代码执行方式与实际器件类似。

通过该调试器系统可以交互方式访问给定器件的所有可用功能，且可通过 MPLAB X IDE 界面设置和修改这

些功能。

MPLAB ICD 5 专为调试嵌入式处理器而开发，具有丰富的调试功能，嵌入式处理器在以下方面与传统系统

处理器有所不同：

• 处理器以最大速度运行

• 多种通信介质（Windows®、Linux®和 macOS®）

• 高级通信介质和协议

• 编程时间短

除了仿真功能外，MPLAB ICD 5 系统也可用作器件生产编程器。

2.1 优势
MPLAB ICD 5 在线调试器系统具有以下优势：

特性/功能：

• 通过高速 USB 2.0 或以太网连接到计算机。

• 全速调试。

• 监视内部文件寄存器。

• 配置引脚驱动器。

• 使用 RJ11 或 RJ45 模块化线缆连接到新目标板。此外，也可以连接到传统目标板。

• 支持多个断点、跑表和源代码文件调试。

• 使用 MPLAB X IDE 或 MPLAB IPE 编程器件。

• 在用户的硬件上实时调试应用程序。

• 基于内部事件设置断点。

• 可通过固件下载进行现场升级。

• 通过安装最新版本的器件和工具包（可从 www.microchip.com/mplabx/免费下载）添加新的器件支持

和功能。

• 可在 0-70°C 的温度范围内工作。

性能/速度：

• 更换器件时不会发生固件下载延迟。

• 具有 384 KB RAM 且在 300 MHz 频率下运行的 32 位 MCU。

• 4 MB 缓冲存储器。

https://www.microchip.com/mplabx/
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安全性：

• 当目标板需要外部电源时，从调试器接收反馈。

• 支持 1.2V 至 5.5V 的目标电源电压。

• 使用以太网供电（Power over Ethernet，PoE）电源或可在 USB Type-C®连接器上提供 3A 电流的 PC
实现最高 1A 的安全供电。

• 在探针驱动器中添加保护电路，以便免受来自目标板的电源浪涌的危害。

• VDD 和 VPP 电压监视器用于过压保护/所有线路均具备过流保护。

• 在确定电压对连接、可编程电阻值和方向（上拉、下拉或不存在）安全之前，电源引脚在物理上是隔离

的。

• 可控编程速度提供了灵活性，能够克服目标板设计问题。

• 符合 CE 和 RoHS 标准（符合行业标准）。

2.2 组件
MPLAB ICD 5 在线调试器工具箱的组件包括：

• 采用耐用黑色金属外壳的长方形 MPLAB ICD 5 设备，带有 LED 指示灯带（见下图）。设备的侧面配有

USB 连接器、以太网连接器和电源连接器，以及通信连接器和调试连接器。

• 计算机与调试器之间通信默认采用的 USB Type-C 转 Type-C 线缆。

• 14 引脚线缆：JTAG 母头扁平带状 IDC 连接器，15 cm。

• 20 引脚线缆：JTAG 母头扁平带状 IDC 连接器，12 cm。

• 8 芯在线串行编程（In-Circuit Serial Programming™，ICSP™）黑色模块化线缆，6 英寸。

• 6 芯 ICSP 灰色模块化线缆，6 英寸。

• 10 引脚线缆：Cortex®母头扁平带状连接器，12 cm。

• 图 2-1. ICD 5 工具箱中包含的组件
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图 2-2. 调试器设备外壳

其他硬件和附件可从 Microchip 直销网站（www.microchipdirect.com）单独订购。

CAT5e/CAT6 以太网线缆可从第三方购买，最好不带水晶头保护套。

已经过试用和测试适用于调试器设备的其他以太网供电（PoE）电源包括：

• Microchip PoE 注入器 30W 55V（桌面式）

• BV-Tech 千兆位 PoE+注入器 30W

• TRENDnet 千兆位 PoE+注入器 30W

已经过试用和测试适用于调试器设备的 USB 隔离器包括：

• IF Tools USB 隔离器 HVC

• HiFimeUSB 隔离器

• Topping HSO2 USB 隔离器

注：KETEREX KX USB-150 无法提供 ICD 5 所需的 500 mA 最低电流。

2.3 框图
以下为 MPLAB ICD 5 设备操作功能的框图。

https://www.microchipdirect.com
https://www.digikey.com/en/products/detail/microchip-technology/PD-9001GR-AT-AC-US/3992861
https://www.amazon.com/BV-Tech-Single-Gigabit-Ethernet-Injector/dp/B005BQUNEG/ref=sr_1_3?crid=3CLWVU6LC7PGA&keywords=poe-i100g&qid=1675279402&sprefix=poe-i100g%2Caps%2C169&sr=8-3&th=1
https://www.amazon.com/TRENDnet-Ethernet-Injector-Distances-TPE-115GI/dp/B00BK4W8TQ/ref=sr_1_3?crid=NGPFRZ9KR4Q3&keywords=trendnet%252Btpe-115gi&qid=1675279443&sprefix=trendnet%252Btpe-115gi%252Caps%252C154&sr=8-3&th=1
https://www.iftools.com/isolator/index.en.php
https://hifimediy.com/product/hifime-high-speed-usb-isolator-v2/
https://apos.audio/products/topping-hs02-usb-2-0-audio-isolator
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2.4 MPLAB® ICD 5 与 MPLAB X IDE 和 MPLAB IPE 配合使用
从 MPLAB X IDE 网页下载最新版本的 MPLAB X IDE 并进行安装。MPLAB X IDE 安装程序将安装 MPLAB X
IDE 和/或 MPLAB IPE。

从 MPLAB 包管理器中更新至最新的 ICD 5 工具包。

MPLAB® ICD 5 与 MPLAB X IDE 配合使用

MPLAB® ICD 5 在线调试器与 MPLAB X IDE 配合使用来开发目标应用程序。MPLAB X IDE 网页中提供用户

指南和其他文档。

表 2-1. MPLAB X IDE 概述

使用桌面图标启动 IDE。

 

新建项目或打开现有项目。选择 MPLAB ICD 5 作为硬件工具。

https://www.microchip.com/en-us/development-tools-tools-and-software/mplab-x-ide
https://www.microchip.com/en-us/development-tools-tools-and-software/mplab-x-ide
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右键单击项目名称并选择“Properties”（属性），打开 Project Properties（项目属

性）窗口。该窗口用于设置调试、编程或其他功能选项。请参见 MPLAB ICD 5 选项说

明。

MPLAB® ICD 5 与 MPLAB IPE 配合使用

MPLAB® ICD 5 在线调试器与 MPLAB IPE 配合使用来作为生产编程器。MPLAB IPE 网页中提供用户指南和

其他文档。

此外，也可以选择使用命令行 IPE 工具。

表 2-2. MPLAB IPE 概述

使用桌面图标启动 IPE。

选择要编程的器件，然后选择 MPLAB ICD 5 作为工具。

单击相应的按钮进行编程、擦除、读取、校验或空白检查。有关 MPLAB IPE（包括高级

模式）的更多信息，请参见 MPLAB IPE User's Guide。

https://www.microchip.com/en-us/tools-resources/production/mplab-integrated-programming-environment
https://ww1.microchip.com/downloads/aemDocuments/documents/DEV/ProductDocuments/UserGuides/MPLAB_IPE_Integrated_Programming_Environment_Users_Guide_50002227.pdf
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3. 连接
进行 MPLAB® ICD 5 在线调试器的硬件设置时，首先为调试器连接电源、通信和目标板。对于传统目标

板，提供了适配器板和线缆。此外，还提供了调试器适配器板，以使 ICD5 支持更多的连接器类型。

3.1 供电和自检
MPLAB ICD 5 可采用 USB-C 供电或以太网供电（PoE），不使用外部电源。MPLAB ICD 5 可通过 PoE 为

目标板供电。即使拔下 USB，PoE 也能为该工具供电。如果客户直接通过 USB-C 为其 MPLAB ICD 5 供

电，则取决于主机 PC 的供电能力（MPLAB X IDE 会在连接 USB 后立即检测）。有关详细信息，请参见电

源规范。

上电自检

MPLAB ICD 5 设备在上电期间执行内置自检（Built-In Self-Test，BIST）。该自检期间出现的错误将在

MPLAB X IDE 或 IPE Output（输出）窗口中报告。不同的错误可以用不同的 LED 颜色指示。

为目标板供电

可使用调试器为目标板供电。有关详细信息，请参见电源规范。

在 Project Properties 窗口中选择该选项（见下图）。还需选择所需目标电压。

图 3-1. 选择目标板的电源

相关信息

电源规范

错误消息

指示灯（LED）
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3.2 PC 连接
MPLAB® ICD 5 在线调试器可使用下表中的连接类型连接到 PC（和 MPLAB X IDE/MPLAB IPE）。

连接类型 连接详细信息 编程和调试* 跟踪 MPLAB®数据可视化器

USB Type-C®（默认） HS USB 2.0 支持（USB 2.0） 支持（SWO） 支持

以太网 直接或通过网络 支持 不支持 不支持

* 有关速度规范，请参见 PC 连接规范。

图 3-2. MPLAB® ICD 5 电源和 PC 连接

首先进行 USB（默认）连接。然后使用 Tools > Manage Network Tools（工具 > 管理网络工具）下的

“Manage Network Tools”对话框切换到 Wi-Fi®或以太网。有关详细信息，请参见以下主题。

选择以太网通信（代替 USB 通信）有以下几种用途：

• 远程访问目标板。可以将调试器和目标板放在一个位置，将 PC 放在另一个位置。

• 隔离目标板。对于需要处于受控环境的目标板，可将其与 PC 隔离。

相关信息

USB Type-C 连接器（J1）和线缆

以太网连接器（J6）和线缆

3.2.1 USB 默认连接

PC 与 MPLAB ICD 5 设备之间默认使用 USB Type-C 线缆进行 USB 连接。建议使用工具包随附的线缆，以

避免发生通信问题。

注：只有 USB 通信可用于跟踪。

注：无论作为 MPLAB X IDE 内的插件还是作为独立应用程序，MPLAB 数据可视化器都是仅在使用 USB 通

信时才能检测到调试器。

如果在使用其他类型的通信时遇到问题，请先返回到 USB，然后使用管理网络工具（Manage Network
Tool，MNT）对话框再次切换到以太网。

3.2.2 以太网模式
MPLAB® ICD 5 在线调试器支持不同模式的以太网通信。

注：专用于局域网，而非广域网。

3.2.2.1 以太网——DHCP
将 MPLAB® ICD 5 在线调试器连接到以太网时，可使用动态主机配置协议（Dynamic Host Configuration
Protocol，DHCP）、静态 IP 或自动私有 IP 寻址（Automatic Private IP Addressing，APIPA）协议。

DHCP（动态主机配置协议）用于将动态 IP 地址分配给联网设备。
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3.2.2.2 以太网——静态 IP
静态 IP 地址是永久分配给网络设备的地址。静态 IP 地址可通过配置过程进行更改，否则为永久地址。

3.2.2.3 以太网——APIPA
自动私有 IP 寻址（APIPA）是 Windows 操作系统中的一项功能，支持计算机在无法访问其 DHCP 服务器

时自动自行配置 IP 地址和子网掩码。将 MPLAB ICD 5 在线调试器连接到以太网时，如果网络没有 DHCP
服务器或不可用，则网络设备将使用 APIPA 为自身分配 IP 地址。APIPA 是一种网络功能，允许网络设备自

动为自身分配 IP 地址。该功能针对小型不可路由网络而开发，因为它可以省去确定哪些 IP 地址可用和手

动为设备分配静态 IP 地址的麻烦。

注：如果网络设备仅使用自身分配的 APIPA 地址，则将只能与同一 APIPA 子网上的其他网络设备连接。

当 DHCP 服务器遇到问题或需要暂时离线，或者目标是创建独立或专用的网络时，可以使用 APIPA 地址建

立临时连接。理想情况下，在解决 DHCP 服务器的 DHCP 问题或设备无法获取 IP 地址时，应使用

APIPA。使用支持网络功能的 Microchip 调试工具时，建议连接到网络并使用其 DHCP 服务器。

APIPA 的 IP 地址范围为 169.254.0.1 至 169.254.255.254。
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3.2.3 以太网——设置和工具发现
遵循下表中列出的步骤设置所需的以太网模式，然后查找连接。

在开始此设置过程之前，需要连接 PoE 注入器。有关已经过测试适用于调试器的 PoE 工具，请参见组件。

只需要进行一次配置，即在 Manage Network Tools 窗口中针对所需协议设置以太网配置。

表 3-1. MPLAB® X IDE 中的以太网设置和工具发现

步骤 操作

1 通过 USB 线缆将调试器连接到 PC。
如果需要进行以太网通信，则必须连接 PoE 注入器。

注：首先需要建立 USB 连接来设置以太网通信。

2 转到 MPLAB X IDE 中的 Tools > Manage Network Tools。

3 在“Network Capable Tools Plugged into USB”（已插入 USB 且支持网络功能的工具）下，选择所用的调试器。

4 在“Configure Default Connection Type for Selected Tool”（为所选工具配置默认连接类型）下，选中所需连接的单选按

钮。
以太网（有线/静态 IP）：输入静态 IP 地址、子网掩码和网关。

注：如需了解如何获取这些输入的信息，请参见图片下方的段落。

单击 Update Connection Type（更新连接类型）。

5 如果选择以太网通信，应确保已连接 PoE 注入器，然后从调试器设备上拔下 USB 线缆。

注：使 Manage Network Tools 窗口保持打开状态。

6 调试器将自动重启，然后以所选的连接模式开始运行。则：

LED 将指示网络连接成功（白色）或网络连接失败/错误（红色）。

7 现在，返回到“Manage Network Tools”对话框，然后单击 Scan（扫描）按钮，随后将在“Active Discovered Network
Tools”（已发现的有效网络工具）下列出所用的调试器。选中该调试器对应的复选框，然后关闭对话框。

8 如果“Active Discovered Network Tools”下未列出所用的调试器，则可在“User Specified Network Tools”（用户指定的

网络工具）部分手动输入信息。必须已知工具的 IP 地址（通过网络管理员或静态 IP 分配的方式获取）。
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调试器和 PoE 设置应如下所示：

图 3-3. 初始 USB 连接

要获取 IP 配置详细信息，应按照以下步骤操作：

1. 在操作系统的搜索栏中输入 cmd以运行命令提示符。
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2. 在出现的黑色窗口中输入 ipconfig，然后按下 Enter（回车）键。

3. 向下滚动以查看 IP 地址、子网掩码和默认网关。

图 3-4. 命令提示符窗口

3.3 目标板连接
MPLAB® ICD 5 在线调试器通过 8 引脚扁平线缆组件连接到目标板。对于传统目标板连接，提供了适配器

板。此外，还有一种在进行功率调试时使用的电流检测连接。

以下章节将讨论器件和通信类型以及可用的适配器板。

注：MPLAB ICD 5 可为目标板供电。有关详细信息，请参见电源规范。在 Project Properties 窗口中

“ICD 5”类别下的“Power”（电源）选项类别中，选择为目标板供电。

图 3-5. MPLAB ICD 5 设备与目标板的连接

3.3.1 通过 RJ-45 型线缆将调试器连接到 RJ-45 目标板

MPLAB ICD 5 在线调试器具有用于与目标板通信的 RJ-45 连接器。将 RJ-45 型线缆连接到 RJ-45 连接器。

将线缆的另一端连接到目标板上的 RJ-45 连接器。

有关此连接的引脚分配，请参见下图。



 
连接

 用户指南

© 2024 Microchip Technology Inc. 及其子公司

DS50003529C_CN - 17

图 3-6. RJ-45 连接到目标板

3.3.2 目标板连接引脚分配
对于不同的器件和接口，编程连接器引脚功能有所不同。有关调试和数据流接口，请参见以下引脚分配

表。此外，也可以使用传统的 6 引脚 RJ-11 线缆，但是使用引脚 1（TMS/SWDIO）和引脚 8（TDI/MOSI）
的目标接口无法进行编程或调试。
注：有关更多信息和图，请参见所用器件的数据手册以及特定接口的应用笔记。
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表 3-2. 调试接口的引脚分配

rotatethispage90 MPLAB ICD 5 调试 目标 4

8
引
脚
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块
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连
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器

1

引
脚

编
号
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脚
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（
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AV
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TP
I

8
引
脚
模
块
化
连
接
器

6
引
脚
模
块
化
连
接
器

8 TTDI TDI TDI MOSI 1

7 TVPP MCLR /Vpp MCLR RESET RESET3 2 1

6 TVDD VDD VDD/VDDIO VDD VTG VTG VTG VTG VTG VTG 3 2

5 GND GND GND GND GND GND GND GND GND GND 4 3

4 PGD DAT TDO SWO2 TDO DAT3 DAT MISO DAT 5 4

3 PGC CLK TCK SWCLK TCK SCK CLK 6 5

2 TAUX RESET RESET/dW CLK RESET RESET 7 6

1 TTMS TMS SWDIO2 TMS 8

rotatethispage90

1. 黑色（8 引脚）线缆必须用于 EJTAG、JTAG、串行线调试（Serial Wire Debug，SWD）和 ISP。

2. 串行线输出（Serial Wire Output，SWO）用于跟踪。SWDIO 用于调试。

3. 在一些器件中，该引脚可用于通过高电压脉冲重新激活统一编程和调试接口（Unified Program and Debug Interface，UPDI）功能。有关详细信息，请参见器件数据手册。

4. 这些是假定与调试器设备相似的目标连接器（模块化）示例。
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图 3-7. 8 引脚模块化连接器

表 3-3. 数据流接口的引脚分配

MPLAB® ICD 5 数据流 目标 2

8 引脚模块化连接器 PIC®和 AVR®器件 SAM 器件 1 8 引脚模块化连接器 6 引脚模块化连接器

引脚编号 DGI UART/CDC DGI UART/CDC 引脚编号 引脚编号

8 TX（目标） TX（目标） 1

7 2 1

6 VTG VTG 3 2

5 GND GND 4 3

4 5 4

3 6 5

2 RX（目标） 7 6

1 RX（目标） 8

1. 为了连接其他器件，移动了 RX 引脚的位置。

2. 这些是假定与调试器设备相似的目标连接器（模块化）示例。

注：将 6 引脚 RJ11 插头插入 8 引脚 RJ45 插座时，引脚 1 和引脚 8 缺失。

3.3.3 调试器适配器板
调试器适配器板是一款连接板，可使 MPLAB ICD 5 和 MPLAB PICkit 5 调试器线缆与带有 Atmel-ICE、功

率调试器和 Arm 型连接器的演示板兼容。此连接板支持 JTAG、SWD 和 ICSP 协议，适用于多种连接器格

式。对于使用 MPLAB PICkit 5 调试器调试 AVR Xplained 演示板来说很实用。
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表 3-4. 连接器到器件的映射

连接器 器件 输入/输出

J1 用于 ICSP™的 RJ-11 模块化连接器（PIC®

MCU）
从工具输入

J2 JTAG/SWD，20 引脚——SAM MCU 输出至目标板

J3 JTAG（MIPS® EJTAG），14 引脚——
PIC32 MCU

输出至目标板

J4 JTAG/SWD，10 引脚 mini——SAM MCU 输出至目标板

J5 ICSP/JTAG，8 引脚 mini——PIC MCU 输出至目标板

J6 用于 ICSP 的 8 引脚单列直插式连接器
（PIC MCU）

从工具输入

J7 AVR® JTAG，10 引脚 mini——AVR MCU 输出至目标板

3.3.3.1 适配器板引脚分配
此连接板支持 JTAG、SWD、ICSP 和 AVR 协议。



 
连接

 用户指南

© 2024 Microchip Technology Inc. 及其子公司

DS50003529C_CN - 21

图 3-8. MPLAB ICD 5 适配器板（AC102015）引脚分配

3.3.4 SAM MCU——JTAG/SWD 接口

SAM 器件具有用于编程和调试的串行线调试（SWD）接口，以及/或者同样用于编程和调试的 JTAG 接口。

查看器件数据手册可以确定具体器件支持的接口。

3.3.4.1 JTAG 物理接口
JTAG 接口包含符合 IEEE® 1149.1 标准的四线测试访问端口（Test Access Port，TAP）控制器。制定 IEEE
标准的目的是提供一种行业标准方式来高效测试电路板连接（边界扫描）。Microchip AVR 和 SAM 器件已

将该功能扩展为包含全面编程和片上调试支持。

要将该目标接口与 MPLAB X IDE 配合使用，请依次打开 Project Properties 窗口，“ICD 5”类别，

“Communications”（通信）选项类别，然后选择 JTAG。对于 MIPS 器件，选择 2 线或 4 线 JTAG。

注：2 线 JTAG 使用标准 ICSP 引脚分配。
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图 3-9. JTAG 接口基本框图
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device

3.3.4.1.1 连接到 SAM JTAG 目标板
MPLAB ICD 5 使用 SAM MCU——JTAG/SWD 接口提供传统 10 引脚 50 mil JTAG 连接以及传统 20 引脚

100 mil JTAG 连接。

直接连接到 10 引脚 50 mil 插座

使用 10 引脚 50 mil 扁平线缆直接连接到插座符合 SAM JTAG 引脚分配（Cortex-M 调试连接器）所示的

Arm Cortex 调试插座引脚分配的目标板。

直接连接到 20 引脚 100 mil 插座

将适配器板插入目标板上的 20 引脚 100 mil 插座。

3.3.4.1.2 SAM JTAG 引脚分配（Cortex-M 调试连接器）
为包含带 JTAG 接口的 Microchip SAM 器件的应用设计 PCB 时，建议使用下图所示的引脚分配。

图 3-10. SAM JTAG 插座引脚分配

TMS
TCK
TDO
TDI
nRESET

VCC
GND
GND

(KEY)
GND

1   2

SAM JTAG

表 3-5. SAM JTAG 引脚说明

名称 引脚 说明

TCK 4 测试时钟（从 MPLAB ICD 5 发送到目标器件的时钟信号）。

TMS 2 测试模式选择（从 MPLAB ICD 5 发送到目标器件的控制信号）。

TDI 8 测试数据输入（从 MPLAB ICD 5 发送到目标器件的数据）。

TDO 6 测试数据输出（从目标器件发送到 MPLAB ICD 5 的数据）。

nRESET 10 复位（可选）。

VTG 1 目标参考电压。MPLAB ICD 5 不使用。

GND 3, 5, 9 地。必须全部连接以确保 MPLAB ICD 5 与目标器件共用相同的参考地。

KEY 7 从内部连接到 AVR®连接器上的 TRST 引脚。建议不要连接。

提示：切记要在 VTG 与 GND 之间连接去耦电容。
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3.3.4.2 SAM SWD 接口
Arm SWD 接口是 JTAG 接口的子集，使用 TCK 和 TMS 引脚。

3.3.4.2.1 连接到 SAM SWD 目标板
连接到 SWD 器件时，可使用 10 引脚 JTAG 连接器。

3.3.4.2.2 SAM SWD 引脚分配
对于 10 引脚 JTAG 连接器：

图 3-11. SAM SWD 插座引脚分配

表 3-6. SAM SWD 引脚说明

名称 SAM 端口引脚 说明

SWDCLK 4 串行线调试时钟

SWDIO 2 串行线调试数据输入/输出

SWO 6 串行线输出（可选——并非所有器件上均实现）

nSRST 10 复位

VTG 1 目标参考电压——MPLAB ICD 5 不使用

GND 3, 5, 9 地

3.3.5 AVR MCU 连接

AVR 器件具有多种编程和调试接口。查看器件数据手册可以确定具体器件支持的接口。

MPLAB ICD 5 ICSP 适配器板可与额外的 AVR 10 引脚或 6 引脚 JTAG 接插板结合使用来连接传统目标板。

掰下所需的接插板（见下图），然后插入适配器板的 8 引脚 SIL 连接器。

3.3.5.1 JTAG 物理接口
JTAG 接口包含符合 IEEE 1149.1 标准的四线测试访问端口（TAP）控制器。制定 IEEE 标准的目的是提供一

种行业标准方式来高效测试电路板连接（边界扫描）。Microchip AVR 和 SAM 器件已将该功能扩展为包含

全面编程和片上调试支持。

要将该目标接口与 MPLAB X IDE 配合使用，请依次打开 Project Properties 窗口，“ICD 5”类别，

“Communications”选项类别。随后将显示 JTAG。选择 JTAG 速度。
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图 3-12. JTAG 接口基本框图
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3.3.5.2 连接到 AVR JTAG 目标板
MPLAB ICD 5 使用 MPLAB ICD 5 ICSP 适配器板和 AVR JTAG（10 引脚）适配器板提供传统 10 引脚 50
mil JTAG 连接。

直接连接到 10 引脚 50 mil 插座

使用“AVR JTAG（10 引脚）”适配器板上的 10 引脚 50 mil 接插连接器直接连接到目标板插座（按照插座

引脚分配）。

3.3.5.3 AVR JTAG 引脚分配
为包含带 JTAG 接口的 AVR 器件的应用设计 PCB 时，建议使用下图所示的引脚分配。

有关其他 AVR 器件连接，请参见 AVR 器件——片上调试（OCD）。

图 3-13. AVR® JTAG 插座引脚分配

表 3-7. AVR® JTAG 引脚说明

名称 引脚 说明

TCK 1 测试时钟（从 MPLAB ICD 5 发送到目标器件的时钟信号）。

TMS 5 测试模式选择（从 MPLAB ICD 5 发送到目标器件的控制信号）。

TDI 9 测试数据输入（从 MPLAB ICD 5 发送到目标器件的数据）。

TDO 3 测试数据输出（从目标器件发送到 MPLAB ICD 5 的数据）。

nTRST 8 测试复位（可选，只有部分 AVR®器件上提供）。用于复位 JTAG TAP 控制器。

nSRST 6 复位（可选）。用于复位目标器件。建议连接该引脚，因为这样 MPLAB ICD 5 便可使目标器件保持复位状态，这对于

某些情况下的调试是必不可少的。

VTG 4* 目标参考电压。MPLAB ICD 5 采样该引脚上的目标电压来为电压转换器正确供电。在该模式下，MPLAB ICD 5 从该引

脚消耗的电流不到 1 mA。

GND 2, 10 地。必须全部连接以确保 MPLAB ICD 5 与目标器件共用相同的参考地。

* 切记要在 VTG 与 GND 之间连接去耦电容。
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3.3.5.4 AVR SPI 物理接口
在线编程使用目标 Microchip AVR 的内部串行外设接口（Serial Peripheral Interface，SPI）将代码下载到

闪存和 EEPROM 存储器中。该接口并非调试接口。

3.3.5.4.1 连接到 AVR SPI 目标板
针对 6 引脚 SPI 连接器建议的引脚分配如 AVR SPI 引脚分配所示。

连接到 6 引脚 100 mil SPI 插座

使用 AVR 6 引脚适配器板连接到标准 100 mil SPI 插座。

连接到 6 引脚 50 mil SPI 插座

使用 AVR 6 引脚 mini 适配器板连接到标准 50 mil SPI 插座。

重要：

编程 debugWIRE 使能（DWEN）熔丝时实际上会禁止 SPI 接口，即使 SPIEN 熔丝也已

编程时也不例外。要重新使能 SPI 接口，必须在处于 debugWIRE 调试会话中时发出

“disable debugWIRE”（禁止 debugWIRE）命令。以这种方式禁止 debugWIRE 时

要求 SPIEN 熔丝已编程。如果 MPLAB X IDE 无法禁止 debugWIRE，可能是因为

SPIEN 熔丝尚未编程。此时，需要使用高电压编程接口来编程 SPIEN 熔丝。

按照弹出窗口中的说明进行操作。

信息：

SPI 接口通常称为“ISP”，因为它是 Microchip AVR 产品上的第一个在线编程（In-
System Programming，ISP）接口。现在可使用其他接口进行在线编程。

3.3.5.4.2 AVR SPI 引脚分配
设计应用 PCB（包含带 SPI 接口的 AVR 器件）时，应使用下图所示的引脚分配。

图 3-14. SPI 插座引脚分配

PDO/MISO
SCK

/RESET

VCC
PDI/MOSI
GND

1   2

SPI

表 3-8. SPI 引脚映射

AVR 端口引脚 目标引脚 SPI 引脚分配

引脚 1（TCK） SCK 3

引脚 2（GND） GND 6

引脚 3（TDO） MISO 1

引脚 4（VTG） VTG 2

引脚 5（TMS）

引脚 6（nSRST） /RESET 5

引脚 7（未连接）

引脚 8（nTRST）

引脚 9（TDI） MOSI 4

引脚 10（GND）
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3.3.5.5 AVR PDI
编程和调试接口（Program and Debug Interface，PDI）为 Microchip 专有接口，用于器件的外部编程和

片上调试。PDI 物理接口是一个 2 引脚接口，可与目标器件进行双向半双工同步通信。

3.3.5.5.1 连接到 AVR PDI 目标板
针对 6 引脚 PDI 连接器建议的引脚分配如 AVR PDI 引脚分配所示。

连接到 6 引脚 100 mil PDI 插座

使用 AVR 6 引脚适配器板连接到标准 100 mil PDI 插座。

连接到 6 引脚 50 mil PDI 插座

使用 AVR 6 引脚 mini 适配器板连接到标准 50 mil PDI 插座。

3.3.5.5.2 AVR PDI 引脚分配
设计应用 PCB（包含带 PDI 接口的 Microchip AVR 器件）时，应使用下图所示的引脚分配。

图 3-15. PDI 插座引脚分配

PDI_DATA

PDI_CLK

VCC

GND

1   2

PDI

(NC)(NC)

表 3-9. PDI 引脚映射

AVR 端口引脚 目标引脚 Microchip STK600 PDI 引脚分配

引脚 1（TCK）

引脚 2（GND） GND 6

引脚 3（TDO） PDI_DATA 1

引脚 4（VTG） VTG 2

引脚 5（TMS）

引脚 6（nSRST） PDI_CLK 5

引脚 7（未连接）

引脚 8（nTRST）

引脚 9（TDI）

引脚 10（GND）

3.3.5.6 AVR UPDI
统一编程和调试接口（UPDI）为 Microchip 专有接口，用于器件的外部编程和片上调试。它是 PDI 双线物

理接口的后继产品，在所有 AVR XMEGA®器件上均有提供。UPDI 是一个单线接口，可与目标器件进行双

向半双工异步通信，从而实现编程和调试。

3.3.5.6.1 UPDI 和/RESET
UPDI 单线接口既可以是专用引脚，也可以是共用引脚，具体取决于目标 AVR 器件。有关更多信息，请查

阅器件数据手册。

当 UPDI 接口位于共用引脚上时，可通过设置 RSTPINCFG[1:0]熔丝将该引脚配置为 UPDI、/RESET 或

GPIO。

RSTPINCFG[1:0]熔丝具有以下配置，如数据手册中所述。这里给出了每个选项的实际意义。

表 3-10. RSTPINCFG[1:0]熔丝配置

RSTPINCFG[1:0] 配置 用途

00 GPIO 通用 I/O 引脚。要访问 UPDI，必须向该引脚施加 12V 脉冲。没有可用的外部复位源。
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...........（续）
RSTPINCFG[1:0] 配置 用途

01 UPDI 专用编程和调试引脚。没有可用的外部复位源。

10 复位 复位信号输入。要访问 UPDI，必须向该引脚施加 12V 脉冲。

11 保留 NA

注：旧款 AVR 器件具有一种称为“高电压编程”（存在串行编程和并行编程两种方式）的编程接口。通

常，在高电压编程过程中，需要在/RESET 引脚上施加 12V 电压。UPDI 接口是一个完全不同的接口。UPDI
引脚主要是一个编程和调试引脚，可通过熔丝配置为其他复用功能（/RESET 或 GPIO）。如果选择其他复

用功能，则需要在该引脚上施加 12V 脉冲来重新激活 UPDI 功能。

注：如果由于引脚数有限而需要在设计中复用 UPDI 信号，则必须采取相应的措施以确保器件可编程。为

了确保 UPDI 信号有效并避免 12V 脉冲损坏外部元件，建议在尝试调试或编程器件时断开该引脚上的所有

元件。这可以使用 0Ω电阻来实现，该电阻默认安装，在进行调试时移除或更换为排针。这种配置实际上

意味着应在安装器件之前完成编程。

3.3.5.6.2 连接到 AVR UPDI 目标板
针对 6 引脚 UPDI 连接器建议的引脚分配如 AVR UPDI 引脚分配所示。

连接到 6 引脚 100 mil UPDI 插座

使用 AVR 6 引脚适配器板连接到标准 100 mil UPDI 插座。

连接到 6 引脚 50 mil UPDI 插座

使用 AVR 6 引脚 mini 适配器板连接到标准 50 mil UPDI 插座。

3.3.5.6.3 AVR UPDI 引脚分配
设计应用 PCB（包含带 UPDI 接口的 Microchip AVR 器件）时，应使用下图所示的引脚分配。

图 3-16. UPDI 插座引脚分配

表 3-11. UPDI 引脚映射

AVR 端口引脚 目标引脚 Microchip STK600 UPDI 引脚分配

引脚 1（TCK）

引脚 2（GND） GND 6

引脚 3（TDO） UPDI_DATA 1

引脚 4（VTG） VTG 2

引脚 5（TMS）

引脚 6（nSRST）

引脚 7（未连接）

引脚 8（nTRST）

引脚 9（TDI）

引脚 10（GND）
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3.3.5.7 AVR TPI
在一些 tinyAVR®器件上，TPI 为仅编程接口，并非调试接口，这些器件没有 OCD 功能。

3.3.5.7.1 连接到 AVR TPI 目标板
针对 6 引脚 TPI 连接器建议的引脚分配如 AVR TPI 引脚分配所示。

连接到 6 引脚 100 mil TPI 插座

使用 AVR 6 引脚适配器板连接到标准 100 mil TPI 插座。

连接到 6 引脚 50 mil TPI 插座

使用 AVR 6 引脚 mini 适配器板连接到标准 50 mil TPI 插座。

3.3.5.7.2 AVR TPI 引脚分配
设计应用 PCB（包含带 TPI 接口的 AVR 器件）时，应使用下图所示的引脚分配。

图 3-17. TPI 连接器引脚分配

TPIDATA
TPICLK
/RESET

VCC

GND

1   2

TPI

(NC)

表 3-12. TPI 引脚映射

AVR 端口引脚 目标引脚 TPI 引脚分配

引脚 1（TCK） CLOCK 3

引脚 2（GND） GND 6

引脚 3（TDO） DATA 1

引脚 4（VTG） VTG 2

引脚 5（TMS）

引脚 6（nSRST） /RESET 5

引脚 7（未连接）

引脚 8（nTRST）

引脚 9（TDI）

引脚 10（GND）

3.3.5.8 AVR debugWIRE
debugWIRE 接口适用于低引脚数器件。与使用 4 个引脚的 JTAG 接口不同的是，debugWIRE 仅使用一个

引脚（/RESET）即可与调试器工具进行双向半双工异步通信。

注：

debugWIRE 接口无法用作编程接口。这意味着，必须额外使用 SPI 接口（如 AVR SPI 引脚分配所示）对目

标器件进行编程。

使用 debugWIRE 启动调试会话时，将使用 debugWIRE 接口对闪存进行编程。这并非出厂编程时可以考虑

的一种选项。

当 debugWIRE 使能（DWEN）熔丝已编程而锁定位尚未编程时，将激活目标器件内的 debugWIRE 系

统。/RESET 引脚将配置为使能上拉的线与（漏极开路）双向 I/O 引脚，并成为目标器件与调试器之间的通

信网关。

3.3.5.8.1 AVR 连接到 debugWIRE
针对 6 引脚 debugWIRE（SPI）连接器建议的引脚分配如 AVR debugWIRE 引脚分配所示。

连接到 6 引脚 100 mil SPI 插座
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使用扁平线缆（在某些工具包中随附）上的 6 引脚 100 mil 分接头连接到标准 100 mil SPI 插座。

连接到 6 引脚 50 mil SPI 插座

使用适配器板（在某些工具包中随附）连接到标准 50 mil SPI 插座。

尽管 debugWIRE 接口只需要使用一根信号线（RESET）、VCC 和 GND 即可正常工作，但仍建议使用完整

的 SPI 连接器，以便可通过 SPI 编程使能和禁止 debugWIRE 接口。

使能 DWEN 熔丝时，将在内部改写 SPI 接口，以便 OCD 模块能够控制 RESET 引脚。debugWIRE OCD 可

暂时禁止自身，从而释放对 RESET 线的控制。SPI 接口随后将再次可用（仅当编程 SPIEN 熔丝后），以允

许使用 SPI 接口取消对 DWEN 熔丝的编程。如果在 DWEN 熔丝取消编程之前重启电源，debugWIRE 模块

将再次控制 RESET 引脚。通常，MPLAB X IDE 或 Microchip Studio 将自动切换接口，但也可以使用

Microchip Studio 的属性对话框中的调试选项卡上的按钮手动切换。

注：强烈建议由 MPLAB X IDE 或 Microchip Studio 来负责将 DWEN 熔丝置 1 和清零。

如果已编程目标 AVR 器件的锁定位，则无法使用 debugWIRE 接口。始终确保在编程 DWEN 熔丝之前清零

锁定位，并且在 DWEN 熔丝编程期间切勿将锁定位置 1。如果 debugWIRE 使能（DWEN）熔丝和锁定位

同时置 1，可以使用高电压编程进行全片擦除，从而清零锁定位。当锁定位清零后，将重新使能

debugWIRE 接口。仅当取消对 DWEN 熔丝的编程时，SPI 接口才能读取熔丝、读取签名和执行全片擦除。

3.3.5.8.2 AVR debugWIRE 引脚分配

为包含带 debugWIRE 接口的 Microchip AVR 器件的应用设计 PCB 时，应使用下图所示的引脚分配。

图 3-18. debugWIRE（SPI）插座引脚分配

PDO/MISO
SCK

/RESET

VCC
PDI/MOSI
GND

1   2

SPI

表 3-13. debugWIRE 引脚映射

AVR®端口引脚 目标引脚 debugWIRE 引脚分配

引脚 1（TCK）

引脚 2（GND） GND 6

引脚 3（TDO）

引脚 4（VTref） VTref 2

引脚 5（TMS）

引脚 6（nSRST） RESET 5

引脚 7（未连接）

引脚 8（nTRST）

引脚 9（TDI）

引脚 10（GND）

3.3.6 PIC32M 连接

基于 MIPS 的 PIC32M 器件使用 EJTAG 进行调试和编程。

3.3.6.1 连接到 PIC32M EJTAG 目标板

MPLAB ICD 5 可直接连接新设计，或者使用适配器板进行传统 14 引脚 10 mil JTAG/EJTAG 连接。

3.3.6.2 PIC32M EJTAG 引脚分配——4 线 JTAG
下表列出了 PIC32M EJTAG 引脚名称及说明。其中分别给出了 MPLAB ICD 5 直接连接和调试器适配器板

14 引脚连接的引脚编号。
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表 3-14. PIC32M JTAG 连接器 14 引脚说明

MPLAB ICD 5
引脚

适配器板（14
引脚）引脚

名称 说明

1 11 MCLR 复位（可选）。用于复位目标器件。建议连接该引脚，因为这样 MPLAB ICD 5 便可使目标器

件保持复位状态，这对于某些情况下的调试是必不可少的。

2 14 VDD MPLAB ICD 5 为目标板供电（可选）或目标板为 MPLAB ICD 5 供电（PTG）。

3 2, 4, 6, 8, 10 GND 地。必须全部连接以确保 MPLAB ICD 5 与目标器件共用相同的参考地。

4 3 TDO 测试数据输出（从目标器件发送到 MPLAB ICD 5 的数据）。

5 9 TCK 测试时钟（从 MPLAB ICD 5 发送到目标器件的时钟信号）。

6 1 NC 未连接。

7 5 TDI 测试数据输入（从 MPLAB ICD 5 发送到目标器件的数据）。

8 7 TMS 测试模式选择（从 MPLAB ICD 5 发送到目标器件的控制信号）。

3.3.7 PIC MCU——ICSP 连接

MPLAB® ICD 5 在线调试器通过 ICSP（在线串行编程）连接支持 PIC 单片机（MCU）和 dsPIC 数字信号控

制器（DSC）的调试和编程。

3.3.7.1 ICSP 目标板连接
在大多数 MPLAB 调试工具上，使用 ICSP 模块化连接器或直插式连接器将调试器直接连接到 PIC MCU 目

标板。调试器适配器板的连接与目标板的连接相同。

如果调试器与目标板采用不同的连接方式（模块化与直插式，或直插式与模块化），可购买一个小型适配

器以确保正确连接：“RJ11 转 ICSP 适配器”（AC164110）。

图 3-19. 6 引脚 RJ11 转 ICSP™适配器

此外，MPLAB ICD 5 还可使用适配器板提供一种 8 引脚 50 mil Microchip 通用连接，对 6 引脚和 8 引脚

ICSP 接口均适用。

3.3.7.2 ICSP 目标板连接电路
下图显示了 MPLAB ICD 5 在线调试器与目标板上 ICSP 连接器的互连。该图还显示了从连接器到目标 PCB
上器件的连接。建议在 VPP/MCLR 线和 VDD 之间连接一个上拉电阻（通常约为 10-50 kΩ），以便将该线

选通为低电平以复位器件。

https://www.microchipdirect.com/dev-tools/AC164110?allDevTools=true
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图 3-20. 与目标电路的标准连接
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4. 工作原理
本章简要概述了 MPLAB ICD 5 在线调试器系统的工作原理，旨在提供足够的信息，帮助用户设计与调试器

兼容的目标板，以进行调试和编程操作。本章还讨论了在线调试和编程的基本原理，以便用户能够快速地

解决遇到的问题。

4.1 MPLAB X IDE 调试
在 Project Properties 窗口中，设置调试、编程或其他选项。请参见调试器选项选择。然后调试项目

。

有关如何使用 MPLAB X IDE 调试应用程序的详细信息，请参见 MPLAB X IDE 网页上的用户指南或

onlinedocs.microchip.com/上的在线帮助版本。

4.2 SAM 和 PIC32C Arm 器件——片上调试
SAM 和 PIC32C 单片机均基于 Arm Cortex-M 内核。可用的调试功能取决于内核类型（见下表）。调试连

接器支持 SWD 和 JTAG。

有关哪些器件具有哪些内核的更多信息，请参见 32 位 PIC®和 SAM 单片机或您所用器件的数据手册。另请

参见由 Arm 提供的 CoreSight 文档。

表 4-1. Cortex®-M 调试和跟踪支持汇总

Cortex®-M 类

型

调试支持

Cortex-M0+ 调试可选：基本调试功能包括处理器暂停、单步执行、处理器内核寄存器访问、复位和硬故障向量捕捉、无限软件

断点、系统存储器完全访问，以及 1/2/3/4 断点和 1/2 观察点功能。

Cortex-M23 调试可选：基本调试功能包括处理器暂停、单步执行、处理器内核寄存器访问、复位和硬故障向量捕捉、无限软件

断点、系统存储器完全访问，以及 1/2/3/4 断点和 1/2/3/4 观察点功能。

Cortex-M4 和
M4F

调试可选：基本调试功能包括处理器暂停、单步执行、处理器内核寄存器访问、向量捕捉、无限软件断点、系统存

储器完全访问，以及各种断点和 1/4 观察点功能。

Cortex-M7 Cortex-M7 调试功能包括处理器暂停、单步执行、处理器内核寄存器访问、向量捕捉、无限软件断点和系统存储器

完全访问。处理器还支持实现期间配置的 4/8 个硬件断点和 2/4 个观察点。

4.3 AVR 器件——片上调试（OCD）
片上调试模块是一种系统，允许开发人员从外部开发平台监视和控制器件中的执行情况，通常通过称为调
试器或调试适配器的设备实现。

凭借 OCD 系统，执行应用程序时可在目标系统中保持准确的电气和时序特性，以便能够依条件或手动停止

执行应用程序以检查程序流和存储器。

运行模式
处于运行模式时，代码执行完全独立于 MPLAB ICD 5。MPLAB ICD 5 将持续监视目标器件是否出现暂停条

件。出现暂停条件时，OCD 系统将通过其调试接口查询器件，以便用户查看器件的内部状态。

停止模式
到达断点时，程序执行将暂停，但一些 I/O 可能如同未出现断点一样继续运行。例如，假定到达断点时，

USART 刚刚开始发送。此时，即使内核处于停止模式，USART 也将继续全速运行，完成发送。

硬件断点
目标 OCD 模块包含多个通过硬件实现的程序计数器比较器。当程序计数器与比较器寄存器之一中存储的值

匹配时，OCD 进入停止模式。由于硬件断点需要使用 OCD 模块上的专用硬件，因此可用断点数取决于目

标器件上实现的 OCD 模块的大小。通常，调试器会“保留”一个此类硬件比较器供内部使用。

https://www.microchip.com/en-us/development-tools-tools-and-software/mplab-x-ide
https://onlinedocs.microchip.com/
https://www.microchip.com/en-us/products/microcontrollers-and-microprocessors/32-bit-mcus
https://developer.arm.com/Processors/Cortex-M4
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软件断点
软件断点是位于目标器件上的程序存储器中的 BREAK指令。加载该指令后，程序执行将暂停，OCD 进入

停止模式。要继续执行，OCD 必须发出“启动”命令。并非所有 Microchip 器件均配备支持 BREAK指令

的 OCD 模块。

4.3.1 AVR 器件接口

注：如果在编程和调试使用 UPDI/PDI/TPI 接口的 AVR 单片机器件时出现问题，请查看所用工具的工程技

术说明（ETN）。

AVR 器件具有多种编程和调试接口。查看器件数据手册可以确定具体器件支持的接口。

• 所有 AVR E/D 器件和新款 tinyAVR 器件具有用于编程和调试的 UPDI 接口。此外，AVR E/D 器件还具有

用于在线编程的 SPI 接口。

• 一些 tinyAVR 器件具有 TPI 接口。TPI 只能用于编程器件。这些器件完全不具备片上调试功能。

• 一些 tinyAVR 器件和一些 megaAVR®器件具有 debugWIRE 接口，该接口连接到称为 tinyOCD 的片上

调试系统。所有具有 debugWIRE 的器件还具有用于在线编程的 SPI 接口。

• 一些 megaAVR 器件具有用于编程和调试的 JTAG 接口以及片上调试系统（也称为 megaOCD）。所有

具有 JTAG 的器件还具有 SPI 接口，该接口用作在线编程的替代接口。

• 所有 AVR XMEGA 器件均具有用于编程和调试的 PDI 接口。一些 AVR XMEGA 器件还具有用于编程和调

试的 JTAG 接口。

表 4-2. 编程和调试接口汇总

UPDI TPI SPI debugWIRE JTAG PDI

AVR® E/D 新器件 新器件

tinyAVR® 新器件 一些器件 一些器件 一些器件

megaAVR® 所有器件 一些器件 一些器件

AVR XMEGA® 一些器件 所有器件

4.3.1.1 AVR E/D OCD——特性
AVR E/D OCD 基于 UPDI 物理接口，这是一个单引脚的编程和调试接口。其他特性包括：

• 两个硬件断点

• 流程、中断和软件断点有变化

• 运行时读取堆栈指针（Stack Pointer，SP）寄存器、程序计数器（Program Counter，PC）和状态寄

存器（SREG）

• 在停止模式下可读写寄存器文件

4.3.1.2 tinyAVR OCD 特性
新款器件的 tinyAVR OCD 基于 UPDI 物理接口，这是一个单引脚的编程和调试接口。tinyAVR OCD 具有以

下特性：

• 针对器件地址空间（NVM、RAM 和 I/O）的存储器映射访问

• 对器件时钟频率没有限制

• 用户程序断点的数量不限

• 两个硬件断点

• 支持高级 OCD 特性

• 无需访问系统寄存器即可进行非侵入式运行时芯片监视

• 用于读取被锁定器件上闪存的 CRC 校验结果的接口

https://microchipdeveloper.com/hwtools:etn
https://microchipdeveloper.com/hwtools:etn
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旧款器件的 tinyAVR OCD 基于 debugWIRE。有关 OCD 特性的更多信息，请参见 debugWIRE OCD 特

性。

4.3.1.2.1 TinyX-OCD（UPDI）特殊注意事项
UPDI 数据引脚（UPDI_DATA）既可以是专用引脚，也可以是共用引脚，具体取决于目标 AVR 器件。共用

的 UPDI 引脚需要使用 UPDI 或 RESET 引脚（具体取决于器件）上的高电压（HV）脉冲来激活。有关详细

信息，请参见器件数据手册。

如果器件上包含循环冗余校验存储器扫描（Cyclic Redundancy Check Memory Scan，CRCSCAN）模

块，则在调试期间，不得在连续后台模式下使用该模块。OCD 模块的硬件断点比较器资源有限，因此在需

要更多断点时，甚至在源代码单步执行期间，可将 BREAK指令插入闪存（软件断点）。CRC 模块可能会将

该断点误检为闪存内容损坏。

CRCSCAN 模块将配置为在引导前执行 CRC 扫描。如果 CRC 不匹配，器件不会进行引导并处于锁定状态。

将器件从该状态恢复的惟一方法是执行全片擦除，然后编程有效闪存映像或禁止引导前 CRCSCAN（如果只

进行全片擦除，将导致闪存清空且 CRC 无效，因此器件仍不会进行引导）。在该状态下对器件进行全片擦

除时，软件前端将自动禁止 CRCSCAN 熔丝。

如果设计的目标应用 PCB 将使用 UPDI 接口，必须考虑以下注意事项才能确保正常工作：

• UPDI 线上的上拉电阻不得小于 10 kΩ。不得使用下拉电阻，使用 UPDI 时应将其移除。UPDI 物理接口

支持推挽功能，因此只需使用弱上拉电阻即可防止在线路空闲时误触发启动位。

• 如果 UPDI 引脚将用作 RESET 引脚，使用 UPDI 时必须断开所有稳定电容，因为这些电容将干扰接口的

正常工作。

• 如果 UPDI 引脚用作 RESET 或 GPIO 引脚，编程或调试期间必须断开线路上的所有外部驱动器，因为这

些驱动器可能干扰接口的正常工作。

4.3.1.2.2 具有 TPI 的 AVR 器件
没有 OCD 的 tinyAVR 器件上具有 Tiny 编程接口（Tiny Programming Interface，TPI）。这些器件无法进

行调试——TPI 仅用于编程。

4.3.1.3 megaAVR OCD 特性
megaAVR OCD 基于 JTAG 物理接口。它具有以下特性：

• 完整程序流控制

• 可完全访问所有寄存器和存储区

• 四个程序存储器（硬件）断点（其中一个保留）

• 硬件断点可组合成数据断点

• 程序断点的数量不限（使用 BREAK）（ATmega128[A]除外）

4.3.1.3.1 megaAVR 特殊注意事项

软件断点
由于 ATmega128[A]包含早期版本的 OCD 模块，因此不支持使用 BREAK指令实现软件断点。

JTAG 时钟
启动调试会话前，必须在软件前端中准确指定目标时钟频率。出于同步原因，JTAG TCK 信号的频率必须小

于 1/4 的目标时钟频率才能实现可靠调试。使用 JTAG 接口编程时，TCK 频率受目标器件最大额定频率的限

制，并非实际使用的时钟频率。

使用内部 RC 振荡器时，注意频率可能因器件而异，并且受温度和 VCC 变化影响。请谨慎指定目标时钟频

率。
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OCDEN 熔丝
为了能够调试 megaAVR 器件，必须编程 OCDEN 熔丝（默认情况下，OCDEN 处于未编程状态）。这样便

可通过访问 OCD 来方便器件调试。软件前端将始终确保启动调试会话时已编程 OCDEN 熔丝，中止会话时

未编程 OCDEN 熔丝，从而限制 OCD 模块产生不必要的功耗。

JTAGEN 熔丝
JTAG 接口使用 JTAGEN 熔丝使能，该熔丝默认处于已编程状态。这样便可访问 JTAG 编程接口。

重要：如果 JTAGEN 熔丝意外禁止，只能使用 SPI 或高电压编程方法重新使能。

如果 JTAGEN 熔丝已编程，仍可在固件中禁止 JTAG 接口，具体方法是将 MCU 控制寄存器中的 JTAG 禁止

位置 1。这将导致代码不可调试，因此在尝试调试会话时不应该这样做。如果启动调试会话时，此代码已

在 Microchip AVR 器件上执行，MPLAB ICD 5 会在连接时将 RESET 线置为有效。如果该 RESET 线接线正

确，将强制目标 AVR 器件进入复位状态，从而实现 JTAG 连接。

如果使能 JTAG 接口，JTAG 引脚将无法用于备用引脚功能。这些引脚将保持用作专用 JTAG 引脚，直到通

过以下方法禁止 JTAG 接口为止：通过程序代码将 JTAG 禁止位置 1 或通过编程接口将 JTAGEN 熔丝清零。

提示：

在 Microchip Studio 中的编程对话框和调试选项对话框中选中“use external
reset”（使用外部复位）复选框，以便 MPLAB ICD 5 能够将 RESET 线置为有效。此

外，这样做还可以在器件上运行的代码禁止了 JTAG 接口（通过将 JTAG 禁止位置 1）时

将其重新使能。

IDR/OCDR 事件
输入/输出数据寄存器（In-out Data Register，IDR）也称为片上调试寄存器（On-Chip Debug Register，
OCDR），当 MCU 在调试会话期间处于停止模式时，调试器频繁使用该寄存器对 MCU 读写信息。当处于

运行模式的应用程序向正在调试的 AVR 器件的 OCDR 寄存器写入一个数据字节时，MPLAB ICD 5 将读取

该值并将其显示在软件前端的消息窗口中。OCDR 寄存器每 50 ms 会被轮询一次，因此以更高的频率写入

该寄存器不会产生可靠结果。如果 AVR 器件在调试期间掉电，可能会报告虚假的 OCDR 事件。发生这种情

况的原因是，当目标电压降至 AVR 最小工作电压以下时，MPLAB ICD 5 可能仍在轮询器件。

4.3.1.4 AVR XMEGA OCD 特性
AVR XMEGA OCD 也称为 PDI（编程和调试接口）。JTAG 和 PDI 这两个物理接口访问器件内的同一个

OCD 实现。它具有以下特性：

• 完整程序流控制

• 可完全访问所有寄存器和存储区

• 一个专用程序地址比较器或符号断点（保留）

• 4 个硬件比较器

• 用户程序断点的数量不限（使用 BREAK指令）

• 对系统时钟频率没有限制

注：对于 ATxmegaA1 系列，仅支持 G 版本或更高版本。
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4.3.1.4.1 AVR XMEGA 特殊注意事项

OCD 和时钟
当 MCU 进入停止模式时，OCD 时钟用作 MCU 时钟。OCD 时钟为 JTAG TCK（使用 JTAG 接口时）或

PDI_CLK（使用 PDI 接口时）。

停止模式下的 I/O 模块
与早期 Microchip megaAVR 器件有所不同，XMEGA 器件中的 I/O 模块在停止模式下停止工作。这意味

着，USART 发送将中断，定时器（和 PWM）将停止工作。

硬件断点
硬件断点比较器共有四个——两个地址比较器和两个值比较器。这些比较器存在特定限制：

• 所有断点必须为相同类型（程序或数据）。

• 所有数据断点必须位于同一存储区（I/O、SRAM 或 XRAM）。

• 如果使用地址范围，则只能有一个断点。

可以设置以下不同组合：

• 两个单数据或程序地址断点。

• 一个数据或程序地址范围断点。

• 两个单数据地址断点（使用单值比较）。

• 一个具有地址范围和/或值范围的数据断点。

无法设置断点时，MPLAB X IDE 和 Microchip Studio 将发出通知并告知原因。如果软件断点可用，则数据

断点的优先级高于程序断点。

JTAGEN 熔丝

JTAG 接口使用 JTAGEN 熔丝使能，该熔丝默认处于已编程状态。这样便可访问 JTAG 编程接口。

重要：如果 JTAGEN 熔丝意外禁止，只能使用 PDI 物理接口重新使能。

如果 JTAGEN 熔丝已编程，仍可在固件中禁止 JTAG 接口，具体方法是将 MCU 控制寄存器中的 JTAG 禁止

位置 1。这将导致代码不可调试，因此在尝试调试会话时不应该这样做。如果启动调试会话时，此代码已

在 Microchip AVR 器件上执行，MPLAB ICD 5 会在连接时将 RESET 线置为有效。如果该 RESET 线接线正

确，将强制目标 AVR 器件进入复位状态，从而实现 JTAG 连接。

如果使能 JTAG 接口，JTAG 引脚将无法用于备用引脚功能。这些引脚将保持用作专用 JTAG 引脚，直到通

过以下方法禁止 JTAG 接口为止：通过程序代码将 JTAG 禁止位置 1 或通过编程接口将 JTAGEN 熔丝清零。

提示：

在 Microchip Studio 中的编程对话框和调试选项对话框中选中“use external
reset”（使用外部复位）复选框，以便 MPLAB ICD 5 能够将 RESET 线置为有效。此

外，这样做还可以在器件上运行的代码禁止了 JTAG 接口（通过将 JTAG 禁止位置 1）时

将其重新使能。

在 ATxmegaA1 版本 H 及更早版本处于休眠模式时进行调试

ATxmegaA1 器件的早期版本存在缺陷，会在器件处于特定休眠模式下时阻止 OCD 使能。可通过以下两种

变通方法重新使能 OCD：
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• 转到 MPLAB ICD 5。在 Tools（工具）菜单的选项中，使能“Always activate external Reset when
reprogramming device”（重新编程器件时始终激活外部复位）。

• 执行全片擦除。

触发该缺陷的休眠模式如下：

• 掉电

• 节能

• 待机

• 扩展待机

4.3.1.5 debugWIRE OCD 特性
debugWIRE OCD 是一个具有有限功能集的专用 OCD 模块，专为低引脚数 AVR 器件设计。它具有以下特

性：

• 完整程序流控制

• 可完全访问所有寄存器和存储区

• 用户程序断点的数量不限（使用 BREAK指令）

• 基于目标时钟自动配置波特率

4.3.1.5.1 debugWIRE 特殊注意事项
debugWIRE 通信引脚（dW）在物理上与外部复位（RESET）位于同一引脚上。因此，使能 debugWIRE
接口时，不支持外部复位源。

必须将目标器件上的 debugWIRE 使能（DWEN）熔丝置 1，debugWIRE 接口才能正常工作。当

Microchip AVR 器件出厂时，该熔丝默认处于未编程状态。debugWIRE 接口本身无法用于将该熔丝置 1。
要将 DWEN 熔丝置 1，必须使用 SPI 模式。如果连接了所需的 SPI 引脚，软件前端将自动进行此处理。此

外，也可在软件前端中使用 SPI 编程手动将其置 1。

方法
1：

尝试在带 debugWIRE 接口的器件上启动调试会话。如果未使能 debugWIRE 接口，软件前端将提示重试或尝

试使用 SPI 编程使能 debugWIRE。如果已连接整个 SPI 插座，则将使能 debugWIRE，系统将要求重启目标板

上的电源。必须满足这一条件才能使熔丝更改生效。

方法
2：

在 SPI 模式下打开 Microchip Studio 中的编程对话框，然后验证签名是否与正确的器件匹配。检查用于使能

debugWIRE 的 DWEN 熔丝。

重要：

务必使 SPIEN 熔丝保持已编程状态，RSTDISBL 熔丝保持未编程状态！如果无法满足上

述条件，器件将困在 debugWIRE 模式，需要通过高电压编程才能恢复 DWEN 设置。

要禁止 debugWIRE 接口，应使用高电压编程取消对 DWEN 熔丝的编程。此外，也可使用 debugWIRE 接

口本身暂时禁止该接口，从而实现 SPI 编程，但前提是 SPIEN 熔丝已置 1。

重要：

如果 SPIEN 熔丝尚未编程，软件前端将无法完成此操作，必须使用高电压编程。

在 MPLAB X IDE 中，如果使能目标器件上的 debugWIRE 并尝试 SPI 编程会话，MPLAB X IDE 将提示先禁

止 debugWIRE。在 Microchip Studio 中，这一操作必须在调试会话期间手动完成，具体方法是从
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“Debug”（调试）菜单中选中“Disable debugWIRE and Close”（禁止 debugWIRE 并关闭）选项。

debugWIRE 接口将暂时禁止，软件前端将使用 SPI 编程来取消对 DWEN 熔丝的编程。

编程 DWEN 熔丝可使时钟系统的某些部分在所有休眠模式下运行。这将增加 AVR 器件在休眠模式下的功

耗。因此，不使用 debugWIRE 时，应始终禁止 DWEN 熔丝。

如果设计的目标应用 PCB 将使用 debugWIRE，必须考虑以下注意事项才能确保正常工作：

• dW/（RESET）线上的上拉电阻不得小于 10 kΩ。debugWIRE 功能无需上拉电阻，因为调试器工具中

会提供。

• 使用 debugWIRE 时必须断开 RESET 引脚上连接的所有稳定电容，因为这些电容将干扰接口的正常工

作。

• 必须断开 RESET 线上的所有外部复位源或其他有效驱动器，因为它们可能干扰接口的正常工作。

切勿编程目标器件上的锁定位。debugWIRE 接口需要锁定位保持清零才能正常工作。

4.3.1.5.2 debugWIRE 软件断点
与 megaAVR（JTAG）OCD 相比，debugWIRE OCD 的规模大幅缩小。这意味着，debugWIRE OCD 没有

可供用户进行调试的程序计数器断点比较器。其中有一个比较器可用于运行到光标和单步执行操作，但其

他用户断点不受硬件支持。

因此，调试器必须转为使用 AVR BREAK指令。该指令可置于闪存中，加载执行时将导致 AVR CPU 进入停

止模式。要在调试期间支持断点，调试器必须在用户请求断点时将 BREAK指令插入闪存。原始指令必须进

行高速缓存处理，以便后续替换。当单步跳过一条 BREAK指令时，调试器必须执行高速缓存的原始指令来

保留程序行为。在极端情况下，必须从闪存中删除 BREAK指令，后续进行替换。上述所有情况均会导致在

从断点单步执行时出现明显延时，如果目标时钟频率非常低，延时问题会更加明显。

因此建议尽可能遵循以下准则：

• 调试期间始终以尽可能高的频率运行目标器件。debugWIRE 物理接口由目标时钟驱动。

• 尝试最大程度减少添加和删除断点的次数，因为每次都需要替换目标器件上的闪存页。

• 尝试每次添加或删除少量断点，以最大程度减少闪存页写操作次数。

• 如有可能，避免在双字指令上放置断点。

4.3.1.5.3 了解 debugWIRE 和 DWEN 熔丝
使能 debugWIRE 接口时，它将控制器件的 RESET 引脚，使其与也需要该引脚的 SPI 接口互斥。使能和禁

止 debugWIRE 模块时，请遵循以下两种方法之一：

• 交给软件前端进行处理（推荐）

• 手动将 DWEN 置 1 和清零（需小心谨慎，仅限高级用户操作！）

重要：手动处理 DWEN 时，必须使 SPIEN 熔丝保持置 1，以免必须使用高电压编程。
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图 4-1. 了解 debugWIRE 和 DWEN 熔丝

Start debug session

Power toggle 
(latches debugWIRE state)

Atmel Studio "Disable debugWIRE and close"
   (disables debugWIRE module temporarily 
    and then clears DWEN fuse using SPI)
MPLAB® X IDE offers to do this automatically 
if an attempt to connect using the SPI interface 
fails due to debugWIRE being enabled

atprogram dwdisable
   (atprogram disables 
    debugWIRE module temporarily)

Clear DWEN fuse
using SPI

Set DWEN fuse
using SPI

Intermediate state 1:
   Fuse DWEN set
   Fuse SPIEN set* (NB!)
   Module debugWIRE disabled until power toggle
You can: Toggle power
 

DWEN
SPIEN

Default state:
   Fuse DWEN cleared
   Fuse SPIEN set
   Module debugWIRE disabled
You can: Access flash and fuses using SPI

DWEN
SPIEN

Debug state:
   Fuse DWEN set
   Fuse SPIEN set
   Module debugWIRE enabled
You can: Use debugWIRE
You cannot: Access fuses or flash using SPI
 

DWEN
SPIEN

Intermediate state 2:
   Fuse DWEN set 
   Fuse SPIEN set
   Module debugWIRE disabled
You can: Access fuses and flash using SPI

DWEN
SPIEN

Debug state (not recommended):
   Fuse DWEN set
   Fuse SPIEN cleared
   Module debugWIRE enabled
You can: Use debugWIRE
To access flash and fuses, it is now necessary to 
use the High-Voltage Programming interface 
 

DWEN
SPIEN

 

4.3.1.6 高级调试（AVR JTAG/debugWIRE 器件）

I/O 外设
即使程序执行因断点停止，大多数 I/O 外设也将继续运行。例如：如果在 UART 发送操作期间到达断点，

将会完成该发送操作，并且相应位将置 1。TXC（发送完成）标志将置 1，在下一次单步执行代码时即可使

用（在实际器件中通常稍后即会发生）。

在停止模式下，除了以下两者之外的所有 I/O 模块都将继续运行：

• 定时器/计数器（可使用软件前端进行配置）

• 看门狗定时器（始终停止工作以防止在调试期间复位）

单步执行 I/O 访问
由于 I/O 在停止模式下继续运行，因此应注意避免某些时序问题。例如以下代码：

OUT PORTB, 0xAA
IN TEMP, PINB

正常运行该代码时，TEMP 寄存器不会读回 0xAA，因为该数据被 IN 操作采样时尚未被物理锁存到引脚。

必须在 OUT与 IN指令之间放置一条 NOP指令，以确保 PIN 寄存器中的值正确无误。

但通过 OCD 单步执行该函数时，该代码会始终将 0xAA置于 PIN 寄存器中，因为即使内核在单步执行期间

停止工作，I/O 也会全速运行。
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单步执行和时序
某些寄存器需要在使能控制信号后一定数量的周期内进行读/写。由于 I/O 时钟和外设在停止模式下继续全

速运行，因此单步执行此类代码不能满足时序要求。在两次单步执行之间，I/O 时钟可能已运行数以百万个

周期。要成功按此时序要求读/写寄存器，应按原子操作执行整个读/写序列，从而全速运行器件。要实现此

目的，可以在调试环境中使用宏或函数调用来执行代码或使用运行到光标功能。

访问 16 位寄存器
Microchip AVR 外设通常包含多个 16 位寄存器，这些寄存器可通过 8 位数据总线进行访问（例如 16 位定

时器的 TCNTn）。16 位寄存器必须使用两次读/写操作进行字节访问。在 16 位访问过程中暂停或单步执

行这种情况可能导致错误值。

受限 I/O 寄存器访问
某些寄存器无法在不影响其内容的情况下进行读取。此类寄存器包括读取时会清零相应标志的寄存器或者
缓冲数据寄存器（如 UDR）。软件前端将阻止在停止模式下读取这些寄存器，以保留 OCD 调试的预期非

侵入特性。此外，一些寄存器无法在不产生副作用的情况下安全写入。这些寄存器是只读的。例如：

• 通过向任何位写入 1清零标志的标志寄存器。这些寄存器是只读的。

• UDR 和 SPDR 寄存器无法在不影响模块状态的情况下进行读取。这些寄存器无法访问。

4.3.2 PIC32M MCU——片上调试

PIC32M MCU 器件支持两种类型的调试：(1)使用 PGECx 和 PGEDx 引脚的在线串行编程（ICSP）和调试；

(2) 4 线 MIPS®增强型 JTAG。

MIPS32 M4K 处理器内核为应用程序和内核代码的软件调试提供了一个增强型 JTAG（EJTAG）接口。除了

标准的 JTAG 指令之外，EJTAG 规范中定义的特殊指令还指定选择的寄存器及其使用方式。有关该接口的详

细信息，请参见器件数据手册。

此外，还有程序断点和复杂数据断点。有关特定 PIC32M 器件的调试功能的详细信息，请参见器件数据手

册。

4.4 PIC MCU/dsPIC DSC——片上调试

片上调试模块是一种系统，允许开发人员从外部开发平台监视和控制器件中的执行情况，通常通过称为调
试器或调试适配器的设备实现。凭借 OCD 系统，执行应用程序时可在目标系统中保持准确的电气和时序特

性（与软件模拟器不同）。该系统能够依条件或手动停止执行应用程序，以检查程序流和存储器。

对于 PIC 单片机（MCU）或 dsPIC 数字信号控制器（DSC），可能需要保留一些器件资源用于调试。

4.4.1 基本调试功能

MPLAB® ICD 5 在线调试器具有以下基本调试功能。

4.4.1.1 启动和停止仿真
要在 MPLAB X IDE 中调试应用程序，必须创建一个包含源代码的项目，以便编译代码、将代码烧写到器件

中并按照如下所述执行代码：

在调试模式下调试或执行项目代码。

暂停或停止代码执行。

暂停或停止后继续代码执行。

对于暂停/停止的代码，单步进入或执行一条指令。注意不要单步进入 Sleep 指令，否则必须执行处理器复位以恢复仿真。
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对于暂停/停止的代码，单步跳过一条指令。

完成调试会话，结束代码执行。

执行处理器复位。根据器件的不同，可能有其他复位（如 POR/BOR、MCLR 和系统复位）。

4.4.1.2 查看处理器存储器和文件
MPLAB X IDE 提供了多个窗口来查看调试信息和各种处理器存储器信息，可在 Window（窗口）菜单中进

行选择。有关使用这些窗口的帮助信息，请参见 MPLAB X IDE 在线帮助。

• Window > Target Memory Views（窗口 > 目标存储器视图）——查看不同类型的器件存储器。存储器

类型包括程序存储器、文件寄存器和配置存储器等，具体取决于所选的器件。

• Window > Debugging（窗口 > 调试）——查看调试信息。从变量、观察、调用堆栈、断点、跑表和跟

踪中进行选择。

要查看源代码，在 Projects 窗口中找到要查看的源代码文件并双击以在 Files（文件）窗口中打开。该窗口

中的代码根据所选处理器和编译工具采用不同颜色标识。要更改颜色标识的样式，请选择 Tools > Options
> Fonts & Colors > Syntax（工具 > 选项 > 字体和颜色 > 语法）。

有关编辑器的更多信息，请参见 MPLAB X IDE 在线帮助的 Editor（编辑器）部分。

4.4.1.3 使用断点
使用断点在代码中的指定行暂停代码执行。

4.4.1.3.1 断点资源
对于 16 位 PIC/dsPIC 器件，断点、数据捕捉和运行时观察使用相同的资源。因此，可用的断点数实际上是

可用的断点和触发的总数。

对于 32 位 PIC 器件，断点使用的资源与数据捕捉和运行时观察不同。因此，可用的断点数与可用的触发数

无关。

可用和/或已用的硬件和软件断点数在 Dashboard（仪表板）（Window > Dashboard（窗口 > 仪表

板））窗口中显示。有关该功能的更多信息，请参见 MPLAB X IDE 文档。并非所有器件都有软件断点。

有关断点操作的限制（包括每个器件硬件断点的常规数目以及硬件断点的断点滑移（skidding）大小），

请参见 MPLAB X IDE Help > Help Contents > Hardware Tool Reference > Limitations - Emulators and
Debuggers（帮助 > 帮助内容 > 硬件工具参考 > 限制——仿真器和调试器））。

4.4.1.3.2 硬件或软件断点选择
要选择硬件或软件断点：

1. 在 Projects 窗口中选择项目，然后单击右键以选择“Properties”。

2. 在 Project Properties 中，选择 ICD 5 > Debug Options（PICkit 5 > 调试选项）。

3. 选中“Use software breakpoints”（使用软件断点）以使用软件断点。取消选中则使用硬件断点。

注：使用软件断点进行调试会影响器件的耐用性。因此，建议不要将以这种方式使用过的器件用作生产器

件。

为帮助您确定使用哪类断点（硬件或软件），下表对每种断点的特性进行了比较。

表 4-3. 硬件断点与软件断点

特性 硬件断点 软件断点

断点数 有限 无限

断点写入到* 内部调试寄存器 闪存程序存储器
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...........（续）

特性 硬件断点 软件断点

断点应用于** 程序存储器/数据存储器 仅程序存储器

设置断点的时间 极短 取决于振荡器速度、编程闪存的时间以及页大
小

断点滑移（skidding） 大多数器件。请参见 MPLAB X IDE Help > Help Contents >
Hardware Tool Reference> Limitations - Emulators and
Debuggers。

无

*器件中写入断点信息的位置。

**适用于断点的器件功能类型。这是设置断点的位置。

4.4.1.4 使用跑表
使用跑表来确定两个断点之间的时间。

注：跑表使用断点资源。

要使用跑表：

1. 在要启动跑表的位置添加一个断点。

2. 在要停止跑表的位置添加另一个断点。

3. 选择 Window > Debugging > Stopwatch（窗口 > 调试 > 跑表）。单击窗口左侧的 Properties 图标，

并选择启动和停止断点。

4. 再次调试程序，以获取跑表计时结果。

图 4-2. 跑表设置
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图 4-3. 具有内容的 Stopwatch 窗口

跑表在窗口左侧具有以下图标：

表 4-4. 跑表图标

图标 图标文本 说明

Properties 设置跑表属性。选择一个当前断点或触发信号来启动跑表，选择另一个断点或触发

信号用于停止跑表。

Reset Stopwatch on Run（在运行时复

位跑表）

在开始运行时将跑表时间复位为零。

Clear History（清除历史记录） 清除跑表窗口。

Clear Stopwatch（清除跑表） （仅对于软件模拟器）在复位器件之后复位跑表。

4.4.1.5 设置冻结外设
对于一些器件和工具，选择“Freeze on Halt”（暂停时冻结）选项可以在暂停时冻结/取消冻结所选外

设。

4.4.2 ICSP 调试

使用 MPLAB ICD 5 在线调试器作为调试器有两个步骤。第一步要求将应用程序烧写到目标器件中（可使用

MPLAB ICD 5 来进行）。第二步是使用目标闪存器件的内部在线调试硬件来运行和测试应用程序。这两步

与 MPLAB X IDE 操作直接相关：

1. 将代码烧写到目标器件并激活具体的调试功能（有关详细信息，请参见下一节）。

2. 使用调试器设置断点并运行。

有关更多信息，请参见 MPLAB X IDE 在线帮助。

如果目标器件不能被正确编程，MPLAB ICD 5 将无法进行调试。

下面给出了 MPLAB ICD 5 的部分内部接口电路的简化图。图中的 Rpu = 10 kΩ（典型值），Ric = 4.7
kΩ。
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图 4-4. 正确的 ICSP™编程连接

编程时，目标器件不需要时钟，但必须为其提供电源。编程时，调试器将编程电压置于 VPP/MCLR 上，通

过 PGC 发送时钟脉冲，通过 PGD 发送串行数据。要校验器件是否已被正确编程，可以向 PGC 发送时钟，

并通过 PGD 读回数据。此操作可确认调试器与器件之间是否正确通信。

4.4.2.1 阻止调试工具正常工作的 ICSP 电路

下图给出了调试器的三根有效线上会阻止 MPLAB ICD 5 在线调试器正常工作的一些元件。

图 4-5. 不正确的电路元件

尤其是必须遵循以下准则：

• 请勿在 PGC/PGD 上使用上拉——它们可能会破坏电压。

• 请勿在 PGC/PGD 上使用电容——它们将阻止数据线和时钟线在编程和调试通信期间快速变化并且会延

长编程时间。

• 请勿在 MCLR 上使用电容——它们将阻止 VPP 快速变化。通常一个简单的上拉电阻就已足够。

• 请勿在 PGC/PGD 上使用二极管——它们将阻止调试器和目标器件之间进行双向通信。

4.4.2.2 进入调试模式的操作序列
假定满足调试要求，将 MPLAB ICD 5 在线调试器设置为 MPLAB X IDE 中的当前工具。转到 File > Project
Properties（文件 > 项目属性），打开对话框，然后在“Hardware Tool”下单击 ICD 5。
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现在可以执行以下操作：

• 选择 Debug > Debug Main Project（调试 > 调试主项目）时，应用程序代码将通过 ICSP 协议编程到器

件的存储器中，如本章开头所述。

• 一个小的“调试执行程序”将加载到目标器件的存储器中。由于某些架构要求调试执行程序必须驻留在
程序存储器中，因此应用程序不能使用此保留的空间。有些器件为调试执行程序提供了专门的存储区。

有关详细信息，请参见器件数据手册。

• 目标器件中的特殊“在线调试”寄存器通过 MPLAB X IDE 使能。这些寄存器允许调试器激活调试执行

程序。有关器件保留资源的更多信息，请参见调试器使用的资源。

• 目标器件在调试模式下运行。

4.4.2.3 调试详细信息
下图显示了准备好开始调试的 MPLAB ICD 5 在线调试器系统。图中的 Rpu = 10 kΩ（典型值），Ric = 4.7
kΩ。

注：提供可编程的上下拉电阻，而非使用固定电阻。

图 4-6. 准备好开始调试的 MPLAB ICD 5——PIC® MCU

为判断应用程序能否正确运行，通常可在程序代码中预先设置断点。当通过 MPLAB X IDE 的用户界面设置

断点时，断点的地址存储在目标器件的特殊内部调试寄存器中。如果仅使用 ICSP，则 PGC 和 PGD 上的命

令直接传送到这些寄存器来设置断点地址。

接下来，通常在 MPLAB X IDE 中选择 Debug > Debug Main Project 功能。调试器指示调试执行程序运行

目标应用程序。目标器件将从复位向量开始执行，直到程序计数器到达先前存储在内部调试寄存器中的断

点地址。

执行断点地址处的指令后，目标器件的在线调试机制会“启动”，并将器件的程序计数器传递给调试执行

程序（类似于中断），用户的应用程序将暂停执行。调试器通过 PGC 和 PGD 与调试执行程序通信，获取

断点状态信息，并将这些信息发送回 MPLAB X IDE。随后，MPLAB X IDE 向调试器发送一系列查询，以获

取关于目标器件的信息，例如文件寄存器内容和 CPU 状态。这些查询由调试执行程序执行。

调试执行程序像程序存储器或专用测试存储器中的应用程序一样运行。它使用堆栈中的某些地址单元存储
临时变量。如果器件没有运行，无论出于何种原因（没有振荡器、电源连接故障和目标板短路等），调试

执行程序都将无法与 MPLAB ICD 5 通信，并且 MPLAB X IDE 将发出一条错误消息。
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暂停目标应用程序的另一种方法是选择 Debug > Pause（调试 > 暂停）。这会翻转 PGC 和 PGD 线，从而

使目标器件的在线调试机制将程序计数器从程序存储器中的用户代码切换到调试执行程序。目标应用程序
暂停，MPLAB X IDE 通过调试器与调试执行程序的通信来查询目标器件的状态。

4.4.2.4 调试要求
要使用 MPLAB ICD 5 在线调试器系统进行调试（设置断点和查看寄存器等），以下关键因素必须正确：

• 调试器必须上电，必须连接到计算机并且必须与 MPLAB X IDE 软件通信。

• 目标器件必须通电且具有正常运行的振荡器。如果目标器件因任何原因无法运行，MPLAB ICD 5 在线调

试器将无法进行调试。

• 必须正确编程目标器件的配置字。这些配置字可使用代码或 MPLAB X IDE 中的 Configuration Bits（配

置位）窗口来设置。

– 振荡器配置位应对应于目标板上的振荡器类型。

– 对于某些器件，看门狗定时器默认使能，需要禁止。

– 不要使能目标器件的任何类型的代码保护功能。

– 不要使能目标器件的表读保护功能。

• 对于具有多个 PGC/PGD 引脚对的某些器件，需要在器件的配置字设置中选择正确的引脚对。这一点仅

针对调试，因为编程可通过任何 PGC/PGD 引脚对工作。

4.4.2.5 调试器使用的资源
对于一些器件，必须使用器件资源进行调试。如需器件的调试器所使用资源的完整列表，请在 MPLAB X
IDE 中选择 Help > Release Notes。除了“Release Notes/Readmes”（发行说明/自述文件）部分以外，

还有“Reserved Resources”（保留资源）部分。选择“Reserved Resources by Device Family and
Tool”（按器件系列和工具保留的资源）或“Reserved Resources by Device for All Tools”（按器件为

所有工具保留的资源）。

4.4.3 编程
注：有关编程的信息，请参见在线帮助。

在 MPLAB X IDE 中，使用 MPLAB ICD 5 作为编程器来编程非-ICE/-ICD 器件，即不在调试头板上的器件。

将 MPLAB ICD 5 设置为当前工具（单击导航窗口中的 Debug Tool ICD 5（调试工具 ICD 5），接着从主菜

单中选择 File > Project Properties 打开对话框，然后在“Hardware Tool”（硬件工具）下单击 ICD 5）
以执行这些操作：

• 选择 Run > Run Main Project（运行 > 运行主项目）图标（见下图）后，应用程序代码将通过 ICSP 协

议编程到器件的存储器中。编程时不需要时钟，可以编程所有的处理器模式，包括代码保护、使能看门

狗定时器和表读保护。

Run Main Project 图标

• 对于某些目标器件，可以将一个小的“编程执行程序”加载到程序存储器的高地址区域中。

• 目标器件中的特殊“在线调试”寄存器以及所有调试功能均通过 MPLAB X IDE 禁止。这意味着不能设

置断点，不能查看或更改寄存器内容。

• 目标器件运行在发布模式下。作为编程器，调试器只能通过翻转 MCLR 线来复位和启动目标器件。
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5. 调试器功能
除了基本调试功能之外，调试器还具有高级调试功能。一些调试功能依赖另一些调试功能。

要查看器件上是否提供某个特定的调试功能，请按以下步骤操作：

• 在 MPLAB X IDE 中的 Help（帮助）菜单上，选择“Release Notes”（发行说明）。

• 除了 Release Notes/Readmes（发行说明/自述文件）之外，再找到 Debug Features Support（调

试功能支持）。

• 单击“Hardware Tool Debug Features by Device”（器件支持的硬件工具调试功能）。

除了前文所述的功能之外，下表还列出了其他调试功能。

表 5-1. 支持的调试器功能

特性 单片机系列*

PIC10/12/16（8
位）

PIC24 和 dsPIC®

（16 位）

PIC32（32 位） AVR®（8 位） SAM（32 位）

虚拟 COM 端口 X X X X X

DGI X X X X X

基本调试 1 X X X X X

SAM ITM/SWO 跟踪 X

PC 性能分析 X

调试器轮询 X X

功率监视 X X X X X

* 并非同一系列的所有器件均提供支持。有关详细信息，请参见如下有关这些功能的各个小节。

1. 运行/暂停、单步和断点，读/写存储器。

5.1 USB CDC 虚拟 COM 端口
桥接目标 UART 与 USB 接口，从而在 USB 主机上提供 CDC 虚拟“COM”端口，对目标板的实际 UART 进

行读/写访问。

当 CI/CD 使用容器时，通过该虚拟端口访问调试器。

CDC/DGI U(S)ART 支持的波特率：7200、9600、14400、19200、28800、38400、57600、76800、
115200、230400、460800 和 921600。

5.2 数据网关接口
数据网关接口（Data Gateway Interface，DGI）用于处理目标 MCU 发起的低级数据传输。DGI 在一些精

选的工具和板上调试器上提供。

DGI 包含多个接口，这些接口使用同一 API 进行配置和通信。每个接口可实现一种对物理通信接口（如

UART）的抽象，或者代表一种并非直接连接到物理通信接口的服务（如时间戳接口）。

MPLAB 数据可视化器应用程序用于实现数据网关接口控制和流传输。该应用程序既可从 MPLAB X IDE 中

调用，也可作为独立程序使用。有关该应用程序和 DGI 的更多信息，请参见 MPLAB 数据可视化器网页。

5.2.1 接口
DGI 的所有功能均以实现的接口为中心。所有接口均使用同一 USB 协议，但每个接口都有自己的配置参

数，单独处理通信。有关详细信息，请参见具体接口章节。请注意，并非所有实现了 DGI 器件的电路板上

均提供所有接口。有关可用的接口，可阅读 USB 协议来确定。

https://www.microchip.com/en-us/development-tools-tools-and-software/embedded-software-center/mplab-data-visualizer
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表 5-2. 接口列表

名称 标识符 说明

Timestamp（时间戳） 0x00 为相关接口上接收的所有事件添加时间戳的服务接口。

UART 0x21 在从模式下直接通过 UART 进行通信。

Power（功率） 0x40（数据） 从连接的功率测量协处理器接收数据和同步事件。

Debugger Polling（调试器轮询） 0x50 轮询程序计数器带时间戳的采样，从而深入了解器件的程序执行情况。

有关更多信息，请参见调试器轮询。

Reserved（保留） 0xFF 用于指示无接口的特殊标识符。

5.2.1.1 时间戳
通过时间戳接口返回的数据是一串有序的带时间戳的数据包，这些数据包属于使能了时间戳功能的接口。

每个数据包中的第一个字节是接口标识符，它将决定必须采用何种方式来解析数据包中的其余字节。

时间戳依赖于 16 位定时器，首先对其进行采样，然后嵌入到每个数据包中。定时器节拍频率可从时间戳配

置中读取，大约在半微秒左右。当定时器溢出时，将在数据流中嵌入溢出包来指示该事件。请注意，如果

定时器溢出时正在嵌入数据包，则将不会嵌入溢出包，而转为由数据包的报头来指示该事件。

所有带时间戳的数据包均依靠 DGI 器件内的模块中断来生成，不会被定时器溢出中断打断。这意味着，定

时器有可能在被采样和嵌入之前已发生溢出。为了能够使时间戳在发生此类事件时保持同步、准确，数据

包还会嵌入定时器溢出位。该位会在定时器后自行采样，即使采样的定时器值已同步，也可能置 1。

5.2.1.2 UART 接口
UART 源对 UART 接口上接收到的原始值进行流传输。

在 Data Sources（数据源）（左侧）窗格中，当选择 UART 源时，UART 设置将显示在下面部分。

注：异步串行协议（例如，DGI UART 和 CDC 虚拟 COM 端口接口使用的 UART 协议）使用 USB CDC 虚

拟 COM 端口部分列出的波特率。

表 5-3. USART Settings（USART 设置）

字段名称 值 用途

Baud Rate（波特率） 0-2000000 异步模式下 UART 接口的波特率

Char Length（字符长度） 5、6、7 或 8 位 每次传输的位数

Parity（奇偶校验） 无奇偶校验、偶校验、奇校验、标记或空格 通信时采用的奇偶校验类型

Stop bits（停止位） 1、1.5 或 2 位 停止位数

5.2.1.3 Power 接口
Power 接口用于测量所连接电路的功耗。

选择调试工具 DGI 下方的 Power 接口。使用“Power Settings”（功率设置）下的控件设置接口。

表 5-4. Power Settings 控件

控件 值 用途

Enabled Channels（使能的通

道）

A 仅使能通道 A。通道 A 始终使能。

Lock Channel A in high range*
（将通道 A 锁定在高电流范围
*）

取消选中或选中 可将通道 A 锁定在高电流范围，以避免自动切换到低电流范围。

这样一来，切换高低电流范围时，便可在不丢失关键采样的前提

下检测到电流消耗中的短尖峰。

Output Voltage in mV（输出电

压（mV））

介于 1600 mV 和 5500 mV 之

间，或为 0
MPLAB® ICD 5 具有可调节的目标电源，可用于为目标应用供

电。该设置用于使能和控制该电源的输出电压。选择 0 将禁止电

源。

* 将来支持的功能。
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提示：任何设置更改都需要在单击 Power Settings 窗格中的 Apply（应用）后才会生

效。例如，要使能电压输出，必须依次单击设置的输出电压值和 Apply，之后才能真正

使能并设置电压输出。

提示：如果调试器已在低电流范围运行，通道 A 范围锁定不会强制调试器返回高电流范

围。此时，只能等待电流升高至足以强制调试器切换电流范围，或者停止并重新启动调

试器。

提示：每个功率信号时间曲线图均占用系统资源。减少同时绘制的曲线图的数量可以优

化性能。

5.3 CI/CD 支持

MPLAB® ICD 5 在线调试器具有网络通信功能，因此可用作硬件测试工具来实现连续集成/连续交付（或部

署）。在 MPLAB X IDE 中，使用 CI/CD 向导创建文件来实现 Jenkins-Docker 或仅 Docker 集成。有关

CI/CD 和使用向导的详细信息，请参见《MPLAB® X IDE 中的 CI/CD 向导用户指南》

（DS50003243A_CN）或《MPLAB® X IDE 用户指南》（DS50002027E_CN）中的相应章节。

如果在向导中选择创建 Jenkins 流水线文件，则可使用向导屏幕（见下表）之一将调试器包含在内。

表 5-5. CI/CD 向导——Hardware Testing（硬件测试）

选项 说明

Enable Hardware Testing（使能硬件测

试）

使能调试器作为测试工具。

Configuration to Build and Run on ICD
5（通过 ICD 5 编译和运行的配置）

选择使用调试器的项目配置；即默认配置或硬件专用配置。

ICD 5 的 IP 地址 输入要使用的调试器的 IP 地址。如果调试器的 IP 地址未知，可使用 ipconfig或类似工

具搜索调试器连接的系统来获取地址。

Enable MPLAB Code Coverage（使能

MPLAB 代码覆盖）

使能 MPLAB®代码覆盖功能。要使用该功能，需要 MPLAB 分析工具套件许可证。

注：如果使能覆盖报告，必须在 Jenkins 服务器上安装代码覆盖 API 插件。

Scan Output for Unity Test Results（扫

描输出以获取 Unity 测试结果）

在按照项目配置编译 Unity 测试运行程序时使能，编译作业随后将基于生成的输出创建报

告。有关如何编写 Unity 测试的更多信息，请参见 Unity——入门。

5.4 Arm ITM/SWO 跟踪

插装跟踪宏单元（Instrumentation Trace Macrocell，ITM）跟踪使用单引脚 SWO 输出 UART 格式的数

据。ITM 可通过多个端口（端口 0 到 31）发送该数据。以下主题将详细介绍 ITM/SWO 跟踪。

并非所有 SAM 器件都具有 ITM 跟踪功能。请参见 MPLAB X IDE 中的 Help > Release Notes > Debug
Features Support > Hardware Tool Debug Features by Device（帮助 > 发行说明 > 调试功能支持 > 器件

支持的硬件工具调试功能）。

5.4.1 ITM 跟踪工作原理

支持 ITM 跟踪的所有 SAM MCU/MPU 均为基于 Arm Cortex-M 处理器的器件，并且采用 Arm CoreSight®

架构。目前，Cortex M3、M4、M33 和 SC300 内核支持 ITM。

CoreSight 插装跟踪宏单元（ITM）模块是由软件应用程序驱动的跟踪源。支持用户代码生成软件插装跟踪
（SoftWare Instrumentation Trace，SWIT）。此外，该模块还提供粗颗粒时间戳功能，其主要用途如

下：

• 支持 printf样式的调试。

https://www.microchip.com/sitesearch/search/All/SW006027-2
https://plugins.jenkins.io/code-coverage-api/
https://github.com/ThrowTheSwitch/Unity/blob/master/docs/UnityGettingStartedGuide.md
https://developer.arm.com/architectures/cpu-architecture/debug-visibility-and-trace/coresight-architecture
https://developer.arm.com/architectures/cpu-architecture/debug-visibility-and-trace/coresight-architecture
https://developer.arm.com/documentation/ddi0314/h/Instrumentation-Trace-Macrocell/About-the-Instrumentation-Trace-Macrocell?lang=en
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• 跟踪 OS 和应用程序事件。

• 发出诊断系统信息。

MPLAB ICD 5 能够将 UART 格式的 ITM 跟踪传输到主机计算机。跟踪在 10 引脚插座的 TRACE/SWO 引脚

（JTAG TDO 引脚）上捕捉。数据在 MPLAB ICD 5 内部缓冲，并通过跟踪接口发送到主机计算机。

注：可以在 MPLAB X IDE 中设置 ITM 波特率。请参见设置 ITM 跟踪。

图 5-1. ITM 框图

ITM 包含以下子模块：

时间
戳

生成时间戳包。

同步
控制

ITM 同步器。

仲裁
器

在同步、时间戳和 SWIT 数据包之间进行仲裁。

FIFO ATB 先进先出（First In First Out，FIFO）。

发射
器

ATB 注册的发射器。

数据通过 APB 接口写入激励寄存器，然后在 ATB 接口上作为 SWIT 数据包发送。

5.4.2 如何将 SWO 与 ITM 跟踪配合使用

CoreSight 串行线输出（SWO）是跟踪数据输出，用作片上跟踪数据与由跟踪端口分析器（Trace Port
Analyzer，TPA）（即 MPLAB ICD 5 在线调试器）捕捉的数据流之间的桥接器。

与跟踪端口接口单元（Trace Port Interface Unit，TPIU）不同，SWO：

• 不包含格式器。

• 不包含模式生成器。

• 包含 8 位 ATB 输入。

• 不包含同步跟踪输出，即，没有 TRACEDATA、TRACECTL 或 TRACECLK 引脚。

• 不支持清理，因为没有此类需求。

• 不支持触发。

• 不包含外部输入和输出（未实现 EXTCTLIN 和 EXTCTLOUT）。

https://developer.arm.com/documentation/ddi0314/h/Serial-Wire-Output/About-the-Serial-Wire-Output?lang=en
https://developer.arm.com/documentation/ddi0314/h/Trace-Port-Interface-Unit/About-the-Trace-Port-Interface-Unit?lang=en
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图 5-2. SWO 框图

5.4.3 ITM/SWO 跟踪要求

下面列出了使用 SAM 器件的跟踪功能的要求：

• MPLAB X IDE v6.10 或更高版本。

• 与支持 SWO 跟踪的器件具有调试和跟踪连接的目标板。

• 如需调试和跟踪支持，可使用以下任一项：

– MPLAB ICD 5 Cortex-M 跟踪适配器板

– ICD 5 JTAG 适配器板（注：SWO 引脚与 JTAG 引脚复用）

– 带有用于连接 8 引脚扁平线缆的连接器的目标板

5.4.4 硬件设置

准备工作
1. 在 PC 与 MPLAB ICD 5 之间使用 USB 通信。其他通信类型不支持跟踪。

2. 确定支持 ITM 跟踪的器件——请参见 Help > Release Notes > Debug Features Support > Hardware
Tool Debug Features by Device。

3. 使用调试器适配器板时，为目标板设计用于调试器-目标板通信和跟踪引脚的连接器。此外，也可将目

标板设计为连接到带调试和跟踪引脚的线缆。

4. 使用跟踪时，将使用目标板上的 TRACESWO 引脚。因此不能使用该引脚上的其他复用功能。

设置硬件
要使用 ITM/SWO 功能：

1. 目标板应处于未上电状态。

2. 在调试器或适配器板与目标板上的通信连接器之间安装通信线缆。

3. 如果使用适配器板，请在适配器板与目标板上的跟踪连接器之间连接跟踪线缆。

4. 为目标板上电。

5.4.5 在 MPLAB X IDE 中设置 ITM
在进行代码开发和调试之前，需要先创建 MPLAB X IDE 项目。然后，可对项目进行配置以支持调试工具功

能。

5.4.5.1 在 MPLAB X IDE 中创建项目

在 MPLAB X IDE 中创建项目时，请注意 ITM/SWO 跟踪要求。有关创建项目的更多信息，请查阅 MPLAB X
IDE 文档。

https://onlinedocs.microchip.com/v2/keyword-lookup?redirect=true&keyword=MPLABX:NEW_PROJECT
https://onlinedocs.microchip.com/v2/keyword-lookup?redirect=true&keyword=MPLABX:NEW_PROJECT


 
调试器功能

 用户指南

© 2024 Microchip Technology Inc. 及其子公司

DS50003529C_CN - 52

为了方便代码开发，可考虑使用 MCC MPLAB Harmony：

1. 选择 Tools > Plugins > Available Plugins > MPLAB Code Configurator（工具 > 插件 > 可用插件 >
MPLAB 代码配置器），然后单击 Install（安装）。MPLAB X IDE 将需要重启。

2. 单击 工具栏图标。请等待 MCC 完成初始化和安装。

3. 在 Content Manager（内容管理器）选项卡中，单击 Select MPLAB Harmony（选择 MPLAB
Harmony）。

4. 确保已下载必选内容并选择应用程序所需的任何可选内容。然后单击 Finish（完成）。

5. 编辑 main()以及创建应用程序所需的其他文件。

5.4.5.2 使用 CMSIS ITM 函数
右键单击 Projects 窗口中的项目名称并选择 Properties。在 Packs（包）下方，除了器件包（DFP）之

外，还包括 CMSIS（见下图）。

通用单片机软件接口标准（Common Microcontroller Software Interface Standard，CMSIS）是与供应

商无关的抽象层，适用于基于 Arm Cortex 处理器的单片机。CMSIS 定义了通用工具接口，可为不同的器

件提供一致的支持。CMSIS 软件接口简化了软件重用，缩短了单片机开发人员的学习曲线，并加快了新器

件的上市速度。

Arm CMSIS 包随附用于发送 ITM 数据的特定头文件/API。例如，在

<MPLAB_Installation>packs\arm\CMSIS\x.x.x\CMSIS\Core\Include\core_cm7.h中，

以下 CMSIS 函数 ITM_SendChar()可用于通过 ITM/SWO 打印字符：

__STATIC_INLINE uint32_t ITM_SendChar(uint32_t ch)

这些是字节级最低级别的 API（仅写入端口 0）；但是，可以定制和开发自己的函数，以将消息打印到任何

端口（端口 0 到 31）（见 Arm ITM/SWO 跟踪）。

__STATIC_INLINE uint32_t ITM_SendCharPort (uint8_t port, uint32_t ch)
{
  if (((ITM->TCR & ITM_TCR_ITMENA_Msk) != 0UL) &&      /* ITM enabled */
      ((ITM->TER & 1UL << port       ) != 0UL)   )     /* ITM Port enabled */
  {
    while (ITM->PORT[port].u32 == 0UL)
    {
       __NOP();
    }
    ITM->PORT[port].u8 = (uint8_t)ch;
  }
  return (ch);
}

//-SL: same as ITM-fct from CMSIS-header (see above), but with portNum
void ITM_PrintString(const char *s, uint8_t portNo)
{
  while (*s!='\0')
  {
    ITM_SendCharPort(portNo,*s++); 
  }
}

https://www.microchip.com/en-us/tools-resources/configure/mplab-harmony#MCC
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或者，如果您不想使用 CMSIS ITM 函数，可以先阅读 Arm CoreSight 文档了解 ITM PORT 寄存器和 ITM
配置/状态寄存器，然后自行编写相关函数。

5.4.5.3 设置时钟
在 Project Properties 对话框中，单击“Categories”下的“ICD 5”。从“Option categories”（选项类

别）下拉菜单中选择“Clock”（时钟），然后在“Target run-time clock frequency (in MHz)”（目标运

行时时钟频率（以 MHz 为单位））中输入数字。

图 5-3. 设置时钟测试

注：这并不会设置时钟，只是将其值告知调试器以进行运行时观察、数据捕捉和跟踪。

5.4.5.4 设置 ITM 跟踪
从“Option categories”下拉菜单中选择“Trace and Profiling”（跟踪和性能分析）。

1. 从“Data Collection Selection”（数据收集选择）下拉菜单中选择“ITM TraceUnder”。

2. 选择“ITM baud rate”（ITM 波特率）以指定 SWO 速度。该值将与时钟一起用于确定 SWO 预分频

值。
注：调试器可使用的 SWO 波特率有限：512 kHz、1 MHz、2 MHz 和 4 MHz。

注：如果应用中涉及时钟切换，建议将 SWO 波特率设置为预计将需要 SWO 功能的时钟速率。

3. 对于一些 SAM 器件，将需要添加.ini文件才能进行其他 ITM 设置。请参见其他初始化文件。

4. 根据需要更改记录设置。

5. 完成后，单击 OK（确定）。

https://developer.arm.com/documentation/ddi0314/h/Instrumentation-Trace-Macrocell/ITM-programmers-model?lang=en
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图 5-4. Trace and Profiling

5.4.5.5 其他初始化文件
SAM E70 和 SAM E54 器件系列的时钟（PLL）与标准 Arm 器件不同，因此需要进行特定的器件配置。这

可通过 ini文件来实现。该文件将在复位时启动。

useroperationsITMSAME70.ini

; Trace Clock Setup
; _WDWORD (0x400E064C, 0x4); // Select Master clock for ITM/ETM
write,0x400E064C, 4

;PMC->PMC_SCER = PMC_SCER_PCK3; // Enable PCK3
write,0x400E0600,0x800

useroperationsITMSAME54.ini

; Trace Clock Setup
; Enable ITM/ETM Peripheral Generic clock and set it to Master Clock
write,0x40001D3C, 0x40

; Configure PB30 to SWO - GPIO PORT MUX
write,0x410080BF,0x07

; Configure Pullups for PB30
write,0x410080DE,0x41

5.4.6 查看 ITM 数据

在执行 Debug Run（调试编译）时，跟踪功能会不断用数据填充跟踪缓冲区，并在缓冲区满或执行暂停时

返回缓冲区起始位置。应用程序将确定如何使用和显示跟踪数据。

注：在有足够的数据填充缓冲区之前，ITM 显示窗口中的数据显示可能会有延迟。处理过程中可能会丢失

一些数据。
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图 5-5. ITM 显示中的输出示例

相关信息

ITM 窗口和相关对话框

5.5 SAM（Arm）——跟踪和性能分析
SAM D5x/E5x Cortex-M4 处理器实现了完整的硬件调试解决方案。这可通过 2 引脚针串行线调试

（SWD）端口使处理器和存储器实现较高的系统可见性，非常适合单片机和其他小型封装器件。

5.5.1 Arm Cortex-M4 处理器——跟踪和性能分析

为进行系统跟踪，处理器将插装跟踪宏单元（ITM）与数据观察点和性能分析单元集成在一起。

为了能够以简单且经济高效的方式对这些功能单元生成的系统事件进行性能分析，可以通过两种不同的方

式导出一连串由软件生成的消息、数据跟踪和性能分析信息：

• 使用 TPIU 在片外输出——通过单个引脚，称为串行线查看器（Serial Wire Viewer，SWV）。仅限于

ITM 系统跟踪。

• 在内部存储在 RAM 中——使用 CoreSight ETB。随后可实现带宽最优化，但容量有限。
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图 5-6. 框图

SWV 跟踪数据在串行线输出（SWO）上输出。

5.5.2 SAM D5x/E5x——ETB 连接

使能 ETB 后，底部 32 KB 的系统存储空间保留用于 CoreSight ETB 调试。下图显示了同时使能纠错码

（Error Correction Code，ECC）和 CoreSight ETB 的示例。

图 5-7. 同时使能 ECC 和 CoreSight ETB 的存储器

5.6 调试器轮询
MPLAB ICD 5 可按照 MPLAB 数据可视化器的指示在与目标器件的有效调试会话期间尽快重复轮询程序计

数器（PC）。尽管这不会产生很高的 PC 采样或代码跟踪百分比，但可用于在代码与功耗关联中捕捉功耗

高于预期的代码部分。相关示例见下图。

有关 MPLAB 数据可视化器的更多信息，请参见 MPLAB 数据可视化器网页。

https://www.microchip.com/en-us/development-tools-tools-and-software/embedded-software-center/mplab-data-visualizer
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图 5-8. 调试器轮询

5.6.1 要求
目前，要使用调试器轮询，必须针对以下受支持的器件设置项目：

• AVR 8 位器件（UPDI 接口）

• Arm 32 位器件（SWD 接口）

5.6.2 工作原理
调试器轮询使用 SAM 32 位器件的 SWD 接口和 AVR 8 位器件的 UPDI 接口来访问内部程序计数器地址单

元。其中提供带时间戳的采样，有助于深入了解器件的程序执行情况。

注：只有从 MPLAB X IDE 内部运行 MPLAB 数据可视化器 时，才能进行调试器轮询。这样，数据可视

化器便可通过 MPLAB X IDE 后端访问器件上的调试系统。

注：调试器轮询要求调试器处于运行状态，即在 MPLAB X IDE 中选择“Debug Project”（调试项目）。

5.7 功率监视器
MPLAB ICD 5 在线调试器可用作功率监视器。功率监视意味着捕捉功率数据，例如电流值。通过调试器供

电时，可以监视 Vdd 和 GND 线并收集功率数据。

功率监视可用于以下 Microchip 器件：PIC、dsPIC、AVR 和 SAM MCU。

DGI（数据网关接口）功率监视仅限于支持 DGI 且配有用于功率测量的附加电路的调试器/工具包，其中包

括 ICD 5。

调试器与 MPLAB 数据可视化器（Data Visualizer，DV）配合使用可提供功率数据曲线图。自 MPLAB X
IDE v5.50 起，IDE 内置 MPLAB DV 插件。此外，也可以使用 MPLAB DV 的独立版本。

注：数据可视化器只能使用 USB 通信。

有关该软件的更多信息，请参见 MPLAB 数据可视化器产品页面。

5.7.1 关于功率监视
当 MPLAB ICD 5 连接到目标板并为其供电时，可以测量以下参数：

https://www.microchip.com/en-us/development-tools-tools-and-software/embedded-software-center/mplab-data-visualizer
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表 5-6. 功率监视器规范

电流和电压 分辨率 满量程

电流 29 μA/步阶 1.0A

电压 0.2087 mV/步阶 6.8V

5.7.2 MPLAB X IDE 设置

在 Project Properties 中（右键单击项目名称，然后选择“Properties”），确保调试器未向目标板供电。

单击 Make and Program Device（编译并编程器件）按钮 ，以编译代码并将代码烧写到目标器件

中。

故障诊断：

• 如果项目编译失败，请检查是否已完全复制并粘贴示例代码。有关更多帮助，另请查看 Output 窗口中

的错误消息。

• 如果 MPLAB X IDE 与调试器或目标板之间的连接有问题，请检查相应连接。

5.7.3 MPLAB 数据可视化器显示

MPLAB 数据可视化器既可在 MPLAB X IDE 内部启动，也可作为独立应用程序启动。

要在 MPLAB X IDE 中打开，请选择 Window > Debugging > Data Visualizer（窗口 > 调试 > 数据可视化

器）。当数据可视化器打开后，MPLAB ICD 5 DGI 列表下将出现 Power 选项，因为正在使用电流检测。单

击该选项可查看 Power Setting 控件。在本用例中，不会使用调试器供电（输出电压 = 0）。
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图 5-9. MPLAB® ICD 5 DGI 选项

单击下拉箭头并选择 Plot all sources（为所有源绘图），为所有功率源绘图。绘图数据将开始传输。
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6. 故障诊断首要步骤
如果 MPLAB ICD 5 在线调试器在工作过程中出现问题，可通过以下各节获得帮助。

6.1 要首先回答的一些问题
1. 使用的是哪款器件？要支持新的器件，通常需要将 MPLAB X IDE 升级到较新的更新包（DFP/TP）版

本。

2. 您使用的是 Microchip 的演示板还是您自己设计的电路板？您是否遵循了用于通信连接的电阻/电容的

准则？请参见目标板连接。

3. 您是否已为目标板供电？有关详细信息，请参见电源规范。

4. 您是否在设置中使用了 USB 集线器？它是否已上电？一些集线器可能与 MPLAB 工具存在兼容性问

题。如果仍有问题，请尝试不使用集线器来连接调试器（将调试器直接插入 PC）。

5. 您是否使用了随调试器一起提供的通信线缆？如果您使用了更长的线缆，则可能导致通信错误。如果需

要更长的线缆，请考虑其他通信类型。请参见 PC 连接。

6. 您是否使用了随调试器一起提供的 USB 线缆？其他 USB 线缆可能质量差、过长或不支持 USB 通信。

6.2 无法调试的首要原因
1. 振荡器不工作。检查与振荡器有关的配置位设置。如果使用的是外部振荡器，请尝试使用内部振荡器重

新进行调试。如果使用的是内部 PLL，请确保 PLL 的设置正确。

2. 目标板未上电。检查目标板或调试器（通过调试器供电时）的电源线缆连接。

3. VDD 电压不正确。VDD 电压超出该器件规范。更多详细信息，请参见器件编程规范。

4. 断开物理连接。调试器已断开与计算机和/或目标板的物理连接。检查通信线缆的连接。

5. 通信中断。PC 与调试器的通信已中断。在 MPLAB X IDE 中重新连接调试器。

6. 器件未安装到位。器件未正确安装在目标板上。如果调试器连接正确并且目标板已通电，但器件未安装

或未完全插入，则可能会收到以下消息：Target Device ID (0x0) does not match expected Device ID
(0x%x)（目标器件 ID（0x0）与预期器件 ID（0x%x）不匹配），其中%x 为预期器件 ID。

7. 器件受到代码保护。检查配置位设置，确认是否使能了代码保护。

8. 无器件调试电路。生产器件可能没有调试功能。根据需要使用处理器扩展包（DS50001292）或调试器

扩展包（DS50002243）。

9. 应用程序代码损坏。目标应用程序损坏或包含错误。尝试重新编译和重新编程目标应用程序。然后对目
标板进行上电复位。

10. 编程引脚不正确。没有在配置位中正确编程 PGC/PGD 引脚对（对于带多个 PGC/PGD 引脚对的器

件）。

11. 需要额外的设置。其他配置设置干扰调试。任何阻止目标器件执行代码的配置设置同样会阻止调试器将
代码置于调试模式。

12. 欠压检测电压不正确。欠压检测电压大于工作电压 VDD。这意味着器件处于复位状态，不能调试。

13. 连接不正确。请参见目标板连接中的准则了解正确的通信连接。

14. 请求无效。调试器无法始终执行请求的操作。

6.3 一般注意事项
1. 通常，编程可能会出现问题。作为测试，使用图标切换为运行模式，然后向目标器件烧写一个尽可能简

单的应用程序（例如，使 LED 闪烁的程序）。如果程序没有运行，则说明目标设置存在错误。

2. 目标器件可能因某种原因（如过流）遭到损坏。开发环境明显对元器件不利。请考虑尝试使用另一个目

标板。
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3. 应用程序将改写调试器的保留资源。请检查链接描述文件和映射文件，以确保应用程序与调试器使用的

RAM 和闪存区域不发生冲突。

4. 查看调试器设置以确保应用设置正确。有关更多信息，请参见工作原理。

5. 可能为您的电路设置了过高的编程速度。在 MPLAB X IDE 中，转至 File>Project Properties，在

“Categories”中选择 ICD 5，然后选择“Program Options”（编程选项）及“Program
Speed”（编程速度），从相应下拉菜单中选择一个较慢的速度。默认设置为“Normal”（正常）。

图 6-1. Program Speed 选项

6. 在某些情况下，调试器可能无法正常运行，可能需要下载固件或需要重新编程调试器。请参见以下部分

以确定其他操作。

6.4 如何使用硬件工具紧急引导固件恢复实用程序

仅使用此实用程序将硬件工具引导固件恢复为出厂状态。仅在硬件工具不能在任何计算

机上运行时使用。

在极少数情况下，可能需要强制调试器进入恢复引导模式（重新编程）；例如，如果在调试器连接到计算

机时发生以下任何情况：

• 调试器没有点亮任何 LED。

• LED 为青色。

重要：必须使用 MPLAB X IDE v6.10 或更高版本才能为 MPLAB ICD 5 使用紧急恢复实

用程序。
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请严格遵循 MPLAB X IDE 中主菜单选项 Debug > Hardware Tool Emergency Boot Firmware Recovery
（调试 > 硬件工具紧急引导固件恢复）下的说明进行操作。

图 6-2. 选择紧急实用程序

如果该过程成功，则恢复向导将显示成功画面。MPLAB ICD 5 现在可以运行，并且能够与 MPLAB X IDE
通信（LED 为紫色）。如果该过程失败，请再次尝试。如果第二次仍然失败，请通过

support.microchip.com 与 Microchip 技术支持联系。

https://support.microchip.com
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7. 常见问题解答（FAQ）
本章提供有关 MPLAB ICD 5 在线调试器系统的常见问题的解答。

7.1 工作原理

芯片中的什么组件允许其与 MPLAB ICD 5 在线调试器通信？
MPLAB ICD 5 可通过 ICSP 及其他目标接口与闪存芯片通信。在一些器件上，该调试器与位于专用存储器

或用户存储器中的调试执行程序进行通信。对于传统 8 位 PIC 器件，调试执行程序位于程序存储器中。在

其他器件上，该调试器直接与芯片的 OCD 模块通信。

必须运行调试执行程序对处理器吞吐量会有什么影响？
运行模式下，调试执行程序并不运行，因此在运行代码时不会降低吞吐量，即调试器不会占用目标器件的

任何周期。

MPLAB X IDE 与 MPLAB ICD 5 在线调试器如何接口来实现比旧版调试工具更多的功能？
MPLAB ICD 5 通过位于专用存储区中的调试执行程序或芯片的 OCD 进行通信。此调试执行程序经过简

化，能够实现更高的通信效率。调试器包含 FPGA、大型 SRAM 缓冲区（1Mx8）和高速 USB 接口。与器

件在线调试器模块接口时，调试器中的 FPGA 用作加速器。

在传统调试器上，数据必须移出到总线上才能对该数据执行复杂触发。MPLAB ICD 5 在线
调试器上是否也需要这样？例如，是否可以根据变为高电平的标志执行暂停操作？
传统调试器使用一个特殊的调试器芯片（-ME）进行监视。MPLAB ICD 5 没有-ME，因此没有要在外部监

视的总线。MPLAB ICD 5 采用调试引擎的内置断点电路而不是外部断点，因此总线和断点逻辑在器件内部

进行监视。

MPLAB ICD 5 在线调试器是否支持复杂断点？
支持。具体取决于器件。如果您的器件支持，则可以根据数据存储单元中的值来暂停程序执行。如果在暂

停程序执行前有多个事件发生，还可以设置顺序断点序列。但只能设置两个序列。此外，还可以设置 AND
条件以及执行 PASS 计数。

这是否会降低程序的运行速度？
MPLAB ICD 5 不占用任何周期。

可以调试以任何速度运行的 dsPIC DSC 器件吗？
MPLAB ICD 5 能够以器件数据手册中指定的任何器件速度进行调试。

7.2 出现的问题
当 MPLAB ICD 5 不按预期工作或完全不工作时，请参见以下章节获取帮助。另请参见错误消息。

7.2.1 我的计算机进入掉电/休眠模式，并且现在调试器无法工作。这是怎么回事？

长时间使用调试器时（尤其是用作调试器时），请确保在计算机操作系统的“电源选项”对话框窗口中禁

止休眠模式。转到休眠选项卡，并取消选中“启用休眠”复选框。这可确保保持所有 USB 子系统组件之间

的所有通信。

7.2.2 编程器件后，执行校验失败。这是编程问题吗？

如果选中 Run Main Project 图标（ ），则器件将在编程后立即自动运行。因此，如果代码对闪存

存储器进行了更改，校验可能会失败。要阻止代码在编程后立即运行，请选择 Hold in Reset（保持复

位）图标（ ）。
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7.2.3 本机跟踪期间我手动暂停了程序，但现在最后一个跟踪记录已丢失。这是怎么回事？

由于手动暂停是异步的，因此最后一段数据可能被丢弃。尝试再次运行并暂停。或者，也可以使用断点暂

停代码。

7.2.4 我已将 16 位器件外设设置为暂停时不冻结，但它却突然发生冻结。这是怎么回事？

对于 dsPIC30F/33F 和 PIC24F/H 器件，外设控制寄存器中的一个保留位（通常为 bit 14 或 bit 5）由调试

器用作 Freeze（冻结）位。如果您对整个寄存器执行过写操作，那么您可能改写了此位（在调试模式下，

用户可访问此位）。为避免上述问题，请只在应用程序中对想要更改的位执行写操作（通过 BTS 和

BTC），而不是对整个寄存器执行写操作（通过 MOV）。

7.2.5 使用 16 位器件时，发生了意外复位。如何确定复位的原因？

考虑以下几个方面：

• 要确定复位源，请检查 RCON 寄存器。

• 在中断服务程序（Interrupt Service Routine，ISR）中处理陷阱/中断。应包括 trap.c样式的代码，

即

void __attribute__((__interrupt__)) _OscillatorFail(void);
        : 
void __attribute__((__interrupt__)) _AltOscillatorFail(void);
        : 
void __attribute__((__interrupt__)) _OscillatorFail(void)
    {
        INTCON1bits.OSCFAIL = 0;        //Clear the trap flag
        while (1);
    }
        : 
    void __attribute__((__interrupt__)) _AltOscillatorFail(void)
    {
        INTCON1bits.OSCFAIL = 0;
        while (1);
    }
    :

• 使用 ASSERT。例如：

ASSERT
      (IPL==7)
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8. 错误消息
MPLAB ICD 5 在线调试器会产生各种不同的错误消息；其中一些错误消息比较特殊，一些是仅供参考的信

息类消息，而其他的都可以用常规纠正措施解决。通常，请阅读错误消息下面的所有指示信息。如果无法

解决问题或者无指示信息，请参见以下章节。

8.1 错误消息类型
以下几节将所选错误消息按照逻辑进行了分类并提出了相应的解决方案。最后一节列出了所有错误消息。

8.1.1 损坏/过时安装错误

Failed to download firmware（无法下载固件）

如果存在 hex 文件：

• 重新连接并重试。

• 如果无法解决问题，则表明该文件可能已损坏。重新安装 MPLAB X IDE。

如果不存在 hex 文件：

• 重新安装 MPLAB X IDE。

Unable to download debug executive（无法下载调试执行程序）

如果尝试调试时收到此错误：

1. 取消将调试器选作调试工具。

2. 关闭项目，然后关闭 MPLAB X IDE。

3. 重新启动 MPLAB X IDE，然后重新打开项目。

4. 重新选择调试器作为调试工具并再次尝试编程目标器件。

Unable to download program executive（无法下载编程执行程序）

如果尝试编程时收到此错误：

1. 取消将调试器选作编程器。

2. 关闭项目，然后关闭 MPLAB X IDE。

3. 重新启动 MPLAB X IDE，然后重新打开项目。

4. 重新选择调试器作为编程器并再次尝试编程目标器件。

如果这些措施无法解决问题，请参见“安装损坏纠正措施”。

8.1.2 调试失败错误
The target device is not ready for debugging.Please check your Configuration bit settings and
program the device before proceeding.（目标器件未准备好调试。请检查配置位设置并编程器件，然

后继续。）

当您尚未编程器件就尝试运行时将收到此消息。如果在编程器件后尝试运行时收到此消息，或者在编程器

件后立即收到此消息：

器件受到代码保护。

您尝试进行操作（读、编程、空白检查或校验）的器件受到代码保护，即，无法读或修改代码。检查配置

位设置，确认是否使能了代码保护（Windows > Target Memory Views > Configuration Bits（窗口 > 目
标存储器视图 > 配置位））。
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要禁止代码保护，请根据器件数据手册，在代码或 Configuration Bits 窗口中置 1 或清零相应的配置位。

然后擦除并重新编程整个器件。

如果这些措施无法解决问题，请参见“调试器与目标器件的通信错误纠正措施”和“调试失败纠正措

施”。

8.1.3 其他错误

ICD 5 is busy. Please wait for the current operation to finish.（ICD 5 忙。请等待当前操作完

成。）

1. 等待。使调试器有时间完成任何应用程序任务。然后重新尝试取消选择调试器。

2. 选择 （结束调试器会话）来停止所有运行中的应用程序。然后重新尝试取消选择调试器。

3. 将调试器从计算机上拔下。然后重新尝试取消选择调试器。

4. 关闭 MPLAB X IDE。

8.1.4 错误消息列表

表 8-1. 按字母顺序排列的错误消息列表

AP_VER=算法插件版本。

AREAS_TO_PROGRAM=将编程以下存储区：

AREAS_TO_READ=将读取以下存储区：

AREAS_TO_VERIFY=将校验以下存储区：

BLANK_CHECK_COMPLETE=空白检查完成，器件空白。

BLANK_CHECKING=正在进行空白检查……

BOOT_CONFIG_MEMORY=引导配置存储器。

BOOT_VER=引导版本。

BOOTFLASH=引导闪存。

BP_CANT_B_DELETED_WHEN_RUNNING=目标器件运行时无法移除软件断点。所选断点将在下次目标器件暂停执行时移除。

CANT_CREATE_CONTROLLER=无法找到工具控制器类。

CANT_FIND_FILE=无法找到文件%s 的位置。

CANT_OP_BELOW_LVPTHRESH=所选电压%f 低于最小擦除电压%f。此电压下无法继续工作。

CANT_PRESERVE_PGM_MEM=无法保留程序存储器：无效范围起始地址 = %08x，结束地址 = %08x。

CANT_READ_REGISTERS=无法读取目标寄存器。

CANT_READ_SERIALNUM=无法读取器件序列号。

CANT_REMOVE_SWPS_BUSY=ICD 5 当前繁忙，此时无法移除软件断点。

CHECK_4_HIGH_VOLTAGE_VPP=注意：检查 MPLAB X IDE 中选择的器件（%s）是否与物理连接到调试工具的器件相同。如果在连

接 3.3V 器件时选择 5V 器件，则会导致调试器检查器件 ID 时损坏器件。是否希望继续操作？

CHECK_PGM_SPEED=您已将编程速度设置为%s。电路板上的电路可能要求您减慢速度。请在工具属性中将设置更改为“低”并再

次尝试操作。

COMM_PROTOCOL_ERROR=调试工具已出现通信错误。工具将复位且应尽快重新枚举。

COMMAND_TIME_OUT=ICD 5 等待命令%02x 的响应超时。

CONFIGURATION=配置。

CONFIGURATION_MEMORY=配置存储器。

CONNECTION_FAILED=连接失败。

CORRUPTED_STREAMING_DATA=检测到无效的数据流。运行时观察或跟踪数据可能不再有效。建议重启您的调试会话。

CPM_TO_TARGET_FAILED=ControlPointMediator.ToTarget()期间出现异常。

DATA_FLASH_MEMORY=数据闪存存储器。

DATA_FLASH=数据闪存。
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DEBUG_INFO_PGM_FAILED=无法进入调试模式，因为调试信息编程失败。配置位的无效组合可能会导致这一问题。

DEBUG_READ_INFO=受目标振荡器速度的影响，在调试模式下读取器件可能会花费较长时间。缩小要读取的范围（在 ICD 5 项目属

性下）可缓解这一情况。中止操作可用于在必要时终止读操作。

DEVICE_ID_REVISION=器件 ID 版本。

DEVICE_ID=器件 ID。

DEVID_MISMATCH=目标器件 ID（0x%x）是无效的器件 ID。请检查与目标器件的连接。

DISCONNECT_WHILE_BUSY=工具在繁忙时断开。

EEDATA_MEMORY=EEData 存储器。

EEDATA=EEData。

EMULATION_MEMORY_READ_WRITE_ERROR=尝试读/写 MPLAB 的仿真存储器时出现错误：地址=%08x。

END=结束。

ENSURE_SELF_TEST_READY=请确保 RJ-11 线缆连接到测试板后再继续。

ENSURE_SELF_TEST_READY=请确保 RJ-11 线缆连接到测试板后再继续。是否要继续？

ENV_ID_GROUP=器件标识。

ERASE_COMPLETE=擦除成功。

ERASING=正在进行擦除……

FAILED_2_PGM_DEVICE=器件编程失败。

FAILED_CREATING_COM=无法创建通信对象（RI4Com）。

FAILED_CREATING_DEBUGGER_MODULES=初始化失败：创建调试器模块失败。

FAILED_ESTABLISHING_COMMUNICATION=无法建立工具通信。

FAILED_GETTING_DBG_EXEC=尝试加载调试执行程序时出现问题。

FAILED_GETTING_DEVICE_INFO=初始化失败：检索器件数据库（.pic）信息时失败。

FAILED_GETTING_EMU_INFO=初始化失败：仿真数据库信息获取失败。

FAILED_GETTING_HEADER_INFO=初始化失败：仿真头数据库信息获取失败。

FAILED_GETTING_PGM_EXEC=尝试加载编程执行程序时出现问题。

FAILED_GETTING_TEX=无法获取 ToolExecMediator。

FAILED_GETTING_TOOL_INFO=初始化失败：检索工具数据库（.ri4）信息时失败。

FAILED_INITING_DATABASE=初始化失败：无法初始化工具数据库对象。

FAILED_INITING_DEBUGHANDLER=初始化失败：无法初始化 DebugHandler 对象。

FAILED_PARSING_FILE=固件文件%s 解析失败。

FAILED_READING_EMULATION_REGS=仿真存储器读取失败。

FAILED_READING_MPLAB_MEMORY=无法读取%s 存储器的%0x08 至%0x08 部分。

FAILED_SETTING_SHADOWS=无法正确设置影子寄存器。

FAILED_SETTING_XMIT_EVENTS=无法同步运行时数据信号量。

FAILED_STEPPING=对目标器件单步执行失败。

FAILED_TO_GET_DEVID=器件 ID 获取失败。请确保目标器件已连接并再次尝试操作。

FAILED_TO_INIT_TOOL=ICD 5 初始化失败。

FAILED_UPDATING_BP=断点更新失败：文件：%s，地址：%08x。

FAILED_UPDATING_FIRMWARE=无法正确更新固件。

FILE_REGISTER=文件寄存器。

FIRMWARE_DOWNLOAD_TIMEOUT=固件下载过程期间 ICD 5 超时。

FLASH_DATA_MEMORY=闪存数据存储器。

FLASH_DATA=闪存数据。

FPGA_VER=FPGA 版本。

FRCINDEBUG_NEEDS_CLOCKSWITCHING=要在调试模式下使用 FRC，必须使能时钟切换配置位设置。请使能时钟切换并重试所请

求的操作。
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FW_DOESNT_SUPPORT_DYNBP=当前 ICD 5 固件不支持为所选器件设置运行时断点。请下载固件版本%02x.%02x.%02x 或更高版

本。

GOOD_ID_MISMATCH=目标器件 ID（0x%x）是有效器件 ID，但与选择的预期器件 ID（0x%x）不匹配。

HALTING=暂停中……

HIGH=高电平。

HOLDMCLR_FAILED=保持复位失败。

IDS_SELF_TEST_PASSED=ICD5 正常工作。如果您的目标电路仍存在问题，请参见在线帮助中的 Target Board Considerations（目

标板注意事项）部分。

IDS_ST_CLKREAD_ERR=测试接口 PGC 时钟线读取失败。

IDS_ST_CLKREAD_NO_TEST=测试接口 PGC 时钟线读取未经测试。

IDS_ST_CLKREAD_SUCCESS=测试接口 PGC 时钟线读取成功。

IDS_ST_CLKWRITE_ERR=测试接口 PGC 时钟线写入失败。请确保测试器连接正确。

IDS_ST_CLKWRITE_NO_TEST=测试接口 PGC 时钟线写入未经测试。

IDS_ST_CLKWRITE_SUCCESS=测试接口 PGC 时钟线写入成功。

IDS_ST_DATREAD_ERR=测试接口 PGD 数据线读取失败。

IDS_ST_DATREAD_NO_TEST=测试接口 PGD 数据线读取未经测试。

IDS_ST_DATREAD_SUCCESS=测试接口 PGD 数据线读取成功。

IDS_ST_DATWRITE_ERR=测试接口 PGD 数据线写入失败。

IDS_ST_DATWRITE_NO_TEST=测试接口 PGD 数据线写入未经测试。

IDS_ST_DATWRITE_SUCCESS=测试接口 PGD 数据线写入成功。

IDS_ST_LVP_ERR=测试接口 LVP 控制线故障。

IDS_ST_LVP_NO_TEST=测试接口 LVP 控制线未经测试。

IDS_ST_LVP_SUCCESS=测试接口 LVP 控制线测试成功。

IDS_ST_MCLR_ERR=测试接口 MCLR 电平故障。

IDS_ST_MCLR_NO_TEST=测试接口 MCLR 电平未经测试。

IDS_ST_MCLR_SUCCESS=测试接口 MCLR 电平测试成功。

IDS_TEST_NOT_COMPLETED=接口测试无法完成。请联系您当地的 FAE/CAE 为设备在 SAR 系统中提交请求以进行维修或替换。

INCOMPATIBLE_FW=ICD 5 固件与 MPLAB X 软件的当前版本不兼容。

INVALID_ADDRESS=操作无法继续，因为%s 地址超出器件地址范围 0x%08x-0x%08x。

MEM_RANGE_ERROR_BAD_END_ADDR=收到无效编程范围结束地址%s。请在调试工具的“Memories to Program”（待编程的

存储器）属性页面上检查手动编程范围。

MEM_RANGE_ERROR_BAD_START_ADDR=收到无效编程范围起始地址%s。请在调试工具的“Memories to Program”属性页面上

检查手动编程范围。

MEM_RANGE_ERROR_END_LESSTHAN_START=收到无效编程范围：结束地址%s < 起始地址%s。请在调试工具的“Memories to
Program”属性页面上检查手动编程范围。

MEM_RANGE_ERROR_ENDADDR_NOT_ALIGNED=收到无效编程范围：结束地址%s 未对齐到适当的 0x%x 地址边界。请在调试工

具的“Memories to Program”属性页面上检查手动编程范围。

MEM_RANGE_ERROR_STARTADDR_NOT_ALIGNED=收到无效编程范围：起始地址%s 未对齐到适当的 0x%x 地址边界。请在调试

工具的“Memories to Program”属性页面上检查手动编程范围。

MEM_RANGE_ERROR_UNKNOWN=尝试验证用户输入的存储器范围时出现未知错误。

MEM_RANGE_ERROR_WRONG_DATABASE=无法在验证用户输入的存储器范围时访问数据对象。

MEM_RANGE_OUT_OF_BOUNDS=所选编程范围%s 未在所选存储区的正确范围内。请在调试工具的“Memories to Program”属

性页面上检查手动编程范围。

MEM_RANGE_STRING_MALFORMED=在“Memories to Program”属性页面上输入的存储器范围（%s）未采用正确格式。

MISSING_BOOT_CONFIG_PARAMETER=无法在数据库中找到引导配置起始/结束地址。

MUST_SET_LVPBIT_WITH_LVP=低电压编程功能需要在目标器件上使能 LVP 配置位。请使能此配置位并再次尝试操作。

NEW_FIRMWARE=现在为目标器件（%s）下载新固件：%s

NMMR=NMMR
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NO_DYNAMIC_BP_SUPPORT_AT_ALL=当前器件不支持在器件运行时设置断点。断点将在下次运行器件之前应用。

NO_PGM_HANDLER=无法编程软件断点。编程处理程序尚未初始化。

NORMAL=正常。

OP_FAILED_FROM_CP=所请求的操作失败，因为器件受到代码保护。

OpenIDE-Module-Name=ICD 5

OPERATION_NOT_SUPPORTED=所选器件不支持此操作。

OUTPUTWIN_TITLE=ICD 5。

PERIPHERAL=外设。

POWER_ERROR_NO_9V=配置为从工具向目标板供电，但未检测到 9V 电源插孔。请确保外部 9V 桶形插孔连接到工具。

POWER_ERROR_NO_POWER_SRC=配置为目标板自行供电，但 VDD 上未检测到任何电压。请确保您已为目标板供电并重试。

POWER_ERROR_POWER_SRC_CONFLICT=配置为从工具向目标板供电，但 VDD 上已检测到电压。这是一种冲突。请确保目标板未

在向工具提供电压并重试。

POWER_ERROR_SLOW_DISCHARGE=VDD 上似乎有多余的电容，导致系统放电变慢和关闭。考虑最大程度减小总电容负载或使用来

自目标板的电源来避免放电延时。

POWER_ERROR_UNKNOWN=发生未知电源错误。

POWER_ERROR_VDD_TOO_HIGH=所需 VDD 电压超出范围。它超出 5.5V 的最大电压。

POWER_ERROR_VDD_TOO_LOW=所需 VDD 电压超出范围。它低于 1.5V 的最小电压。

POWER_ERROR_VPP_TOO_HIGH=所需 VPP 电压超出范围。它超出 14.2V 的最大电压。

POWER_ERROR_VPP_TOO_LOW=所需 VPP 电压超出范围。它低于 1.5V 的最小电压。

PRESERVE_MEM_RANGE_ERROR_BAD_END_ADDR=收到无效保留范围结束地址%s。请在调试工具的“Memories to Program”

属性页面上检查手动编程范围。

PRESERVE_MEM_RANGE_ERROR_BAD_START_ADDR=收到无效保留范围起始地址%s。请在调试工具的“Memories to
Program”属性页面上检查手动编程范围。

PRESERVE_MEM_RANGE_ERROR_END_LESSTHAN_START=收到无效保留范围：结束地址%s < 起始地址%s。请在调试工具的

“Memories to Program”属性页面上检查手动编程范围。

PRESERVE_MEM_RANGE_ERROR_ENDADDR_NOT_ALIGNED=收到无效保留范围：结束地址%s 未对齐到适当的 0x%x 地址边界。

请在调试工具的“Memories to Program”属性页面上检查手动编程范围。

PRESERVE_MEM_RANGE_ERROR_STARTADDR_NOT_ALIGNED=收到无效保留范围：起始地址%s 未对齐到适当的 0x%x 地址边

界。请在调试工具的“Memories to Program”属性页面上检查手动编程范围。

PRESERVE_MEM_RANGE_ERROR_UNKNOWN=尝试验证用户输入的保留范围时发生未知错误。

PRESERVE_MEM_RANGE_ERROR_WRONG_DATABASE=无法在验证用户输入的存储器范围时访问数据对象。

PRESERVE_MEM_RANGE_MEM_NOT_SELECTED=您已选择保留一个存储区，但尚未选择编程该存储区。请在调试工具的

“Memories to Program”属性页面上检查保留范围，并确保保留的任何存储器也被指定为编程。

PRESERVE_MEM_RANGE_OUT_OF_BOUNDS=所选保留范围%s 未在所选存储区的正确范围内。请在调试工具的“Memories to
Program”属性页面上检查手动编程范围。

PRESERVE_MEM_RANGE_STRING_MALFORMED=在“Memories to Program”属性页面上输入的保留存储器范围（%s）未采用正

确格式。

PRESERVE_MEM_RANGE_WONT_BE_PROGRAMMED=在“Memories to Program”属性页面上输入的保留存储器范围（%s）的

部分或全部未处于所选存储器的指定编程范围（%s）内。请在调试工具的“Memories to Program”属性页面上检查保留范围。

PROGRAM_COMPLETE=编程/校验完成。

PROGRAM_MEMORY=程序存储器。

PROGRAM=编程。

PROGRAMMING_DID_NOT_COMPLETE=编程未完成。

READ_COMPLETE=读取完成。

READ_DID_NOT_COMPLETE=读取未完成。

RELEASEMCLR_FAILED=从复位释放失败。

REMOVING_SWBPS_COMPLETE=软件断点删除完成。

REMOVING_SWBPS=正在删除软件断点……

RESET_FAILED=器件复位失败。
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RESETTING=正在复位……

RUN_INTERRUPT_THREAD_SYNCH_ERROR=发生内部运行错误。建议重启您的调试会话。您可以继续运行，但某些运行时功能可

能无法正常工作。

RUN_TARGET_FAILED=无法运行目标器件。

RUNNING=正在运行。

SD_RESULT_NO_ERROR=跟踪文件结果为空

SERIAL_NUM=序列号：\n

SETTING_SWBPS=正在设置软件断点……

STACK=堆栈。

START_AND_END_ADDR=起始地址 = 0x%x，结束地址 = 0x%x。

START=起始。

TARGET_DETECTED=检测到目标电压。

TARGET_FOUND=找到目标器件%s。

TARGET_HALTED=目标器件暂停执行。

TARGET_NOT_READY_4_DEBUG=目标器件未准备好调试。请检查配置位设置并编程器件，然后继续。此故障最常见的原因是振荡

器和/或 PGC/PGD 设置。

TARGET_VDD=目标 VDD：

TEST=测试。

TOOL_IS_BUSY=ICD 5 繁忙。请等待当前操作完成。

TOOL_VDD=VDD：

TOOL_VPP=VPP：

UNABLE_TO_OBTAIN_RESET_VECTOR=ICD 5 无法检索复位向量地址。这表示未定义_reset 符号，因此不会阻止器件正常启动。

UNKNOWN_MEMTYPE=存储器类型未知。

UNLOAD_WHILE_BUSY=ICD 5 在繁忙时卸载。在再次使用 ICD 5 之前，请拔下并重新连接 USB 线缆。

UPDATING_APP=正在更新固件应用程序……

UPDATING_BOOTLOADER=正在更新固件自举程序……

UPDATING_FPGA=正在更新固件 FPGA……

USE_LVP_PROGRAMMING=注：如果要使用低电压编程对此器件进行编程，请在此对话框中选择 Cancel（取消）。然后转到项目

属性的 ICD5 节点，并选中 Program Options 选项类别窗格的 Enable Low Voltage Programming（使能低电压编程）复选框（低

电压编程对调试操作无效）。

USERID_MEMORY=用户 ID 存储器。

USERID=用户 ID。

VERIFY_COMPLETE=校验成功。

VERIFY_FAILED=校验失败。

VERSIONS=版本。

VOLTAGES=电压。

WOULD_YOU_LIKE_TO_CONTINUE=是否要继续？

8.2 常规纠正措施
以下各节中的常规纠正措施可解决您的问题。

8.2.1 读/写错误纠正措施

如果收到读或写错误：

1. 是否单击了 Debug > Reset？此操作可能产生读/写错误。

2. 重试操作。该错误可能只发生一次。

3. 确保目标板已上电并且器件的电压正确。有关所需器件电压，请参见器件数据手册。

4. 确保调试器到目标器件的连接正确（PGC 和 PGD 已连接）。
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5. 对于写错误，确保在调试器的 Program Options 上选中“Erase all before Program”（编程之前全

部擦除）（见“编程选项”部分）。

6. 确保所使用的线缆的长度正确。

8.2.2 调试器与目标器件的通信错误纠正措施
如果 MPLAB ICD 5 在线调试器与目标器件之间不能通信：

1. 选择 Debug > Reset，然后重试操作。

2. 确保所使用的线缆的长度正确。

8.2.3 调试器与计算机的通信错误纠正措施
如果 MPLAB ICD 5 在线调试器与 MPLAB X IDE 之间不能通信：

1. 从计算机上拔下调试器，然后重新插入。

2. 重新连接调试器。

3. 重试操作。该错误可能只发生一次。

4. MPLAB X IDE 中安装的更新包（DPF/TP）的版本可能不适用于目标器件。有关如何安装更新包的信

息，请参见 MPLAB X IDE 文档。

5. 计算机 USB 端口可能存在问题。请参见“USB 端口通信错误纠正措施”部分。

8.2.4 安装损坏纠正措施
该问题很可能是由于 MPLAB X IDE 的安装不完整或者损坏引起：

1. 卸载计算机上所有的 MPLAB X IDE 版本。

2. 重新安装所需的 MPLAB X IDE 版本。

3. 如果问题依然存在，请联系 Microchip 技术支持。

8.2.5 USB 端口通信错误纠正措施

该问题很可能是由于通信端口故障或者不存在引起：

1. 重新连接 MPLAB ICD 5 在线调试器。

2. 确保调试器已物理连接到计算机上适当的 USB 端口。

3. 确保在调试器选项中选择了适当的 USB 端口（见“调试器选项选择”部分）。

4. 确保 USB 端口未被其他设备使用。

5. 如果使用 USB 集线器，请确保已将其上电。

6. 确保已加载 USB 驱动程序。

8.2.6 调试失败纠正措施
MPLAB ICD 5 在线调试器无法执行调试操作。导致此错误的情况有很多，其中几个如下所述。

1. 器件没有时钟源，或者配置位设置中选择的时钟源不工作。

2. 器件上的 PGD（数据）和 PGC（时钟）引脚正在被应用使用。这两个引脚为调试器所需，在调试模式

期间不得被应用控制。

3. 许多器件包含多个 PGD/PGC 对。使用配置位设置来选择用于调试的 PGD/PGC。在编程模式下，可以

使用连接到调试工具的任何 PGD/PGC 对。对于调试模式，配置位设置必须与物理连接到 MCU 的

PGD/PGC 对相匹配。
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4. 当器件尚未编程时，从 MPLAB X IDE 中选择 Run Main Project 将生成此消息。此时，可改用调试模式

（ ）。

此信息基于知识库文章 Why do I get the following error while trying to debug: "ICD3Err0040: The
target device is not ready for debugging"?。

8.2.7 内部错误纠正措施
内部错误难以预料并且不应该发生。它们用于 Microchip 内部开发。

最可能的原因是安装损坏（安装损坏纠正措施）。

另一个可能的原因是系统资源不足：

1. 尝试重新启动系统以释放存储空间。

2. 确保硬盘上有足够的可用空间（而且没有过多的磁盘碎片）。

如果问题依然存在，请联系 Microchip 技术支持。

https://microchip.my.site.com/s/article/KB100162
https://microchip.my.site.com/s/article/KB100162
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9. 调试器功能汇总
以下主题汇总了 MPLAB® ICD 5 在线调试器的功能。

9.1 调试器选择与切换
使用 Project Properties 对话框可为项目选择或切换调试器。要进行切换，必须有多个 MPLAB® ICD 5 在

线调试器与计算机相连。MPLAB X IDE 将通过显示两个不同序列号来区分两个调试器。

要选择或更改项目使用的调试器：

1. 通过执行下列一项操作打开 Project Properties 对话框：

a. 单击 Projects 窗口中的项目名称，然后选择 File > Project Properties。
b. 右键单击 Projects 窗口中的项目名称并选择 Properties。

2. 在“Categories”下，单击“Conf: [default]”。

3. 在“Hardware Tools”下，找到“ICD 5”并单击序列号（Serial Number，SN）来选择项目中使用的

调试器。

9.2 调试器选项选择
在 Project Properties 对话框的调试器属性页面上设置调试器选项。

1. 通过执行下列一项操作打开 Project Properties 对话框：

a. 单击 Projects 窗口中的项目名称，然后选择 File > Project Properties。
b. 右键单击 Projects 窗口中的项目名称，然后选择“Properties”。

2. 在“Categories”下，单击 ICD 5。

3. 从“Options categories”中选择属性页面。单击某个选项可在下面的文本框中查看其说明。单击选项

的右侧可对其进行更改。
注：显示的选项可能因器件而异。
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图 9-1. 项目属性——ICD 5 选项

9.2.1 Memories to Program
选择目标器件中要编程的存储器。

如果在 Program Options 下选择了“Erase All Before Program”，则编程前将擦除所有器件存储器。要

选择在擦除后仅编程某些存储器，应选中特定的存储器类型。要保留不同类型的存储器的值，选中时可保

留存储器类型并选中特定的存储器类型；选中“Preserve Memory”（保留存储器）可在擦除前将当前内

容写入缓冲区，选中“Memory”（存储器）可在擦除后将内容写回该存储器，这里的 Memory 是存储器

类型，例如 EEPROM。

表 9-1. Memories to Program 选项类别

Auto select memories and ranges
（自动选择存储器和范围）

Allow ICD 5 to Select Memories（允许 ICD 5 选择存储器）——调试器根据选择的器件和

默认设置确定要编程的存储器和范围。
Manually select memories and ranges（手动选择存储器和范围）——选择要编程的存

储器的类型和范围（见下文）。

Configuration Memory（配置存储

器）（始终在调试模式下编程）

选中时可在发布模式下编程配置存储器。对于双分区器件，分区 2 将有另一个选择。

Memory 选中时可编程 Memory。存储器的类型包括：指令 RAM、闪存数据、数据闪存、

EEPROM、ID 存储器、引导闪存和辅助存储器。

Memory Range(s) (hex)（存储器范围

（十六进制））*
Memory 中的起始和结束十六进制地址范围。存储器的类型包括：指令 RAM。

程序存储器 选中时可编程下面指定的目标程序存储器范围。

Program Memory Range(s) (hex)
（程序存储器范围（十六进制））*

程序存储器中要编程、读取或校验的起始和结束十六进制地址范围。
注：地址范围不适用于擦除功能。擦除功能将擦除器件上的所有数据。

Preserve Program Memory（保留程

序存储器）

选中时不会编程下面指定的目标程序存储器范围。
确保代码不受代码保护。
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Preserve Program Memory Range(s)
(hex)（保留程序存储器范围（十六进

制））*

编程、读取或校验时目标程序存储器中要保留的起始和结束十六进制地址范围。
此存储区从目标器件中读取且覆盖现有的 MPLAB® X IDE 存储区。

Preserve Memory 选中时会保留 Memory 以对其进行重新编程。存储器的类型包括：指令 RAM、闪存数据、

数据闪存、EEPROM、ID 存储器、引导闪存和辅助存储器。

确保代码不受代码保护。

Preserve Memory Range(s) (hex)
（保留存储器范围（十六进制））*

编程、读取或校验时目标 Memory 中要保留的起始和结束十六进制地址范围。存储器的类型

包括：指令 RAM、闪存数据、数据闪存、EEPROM、引导闪存和辅助存储器。

此存储区从目标器件中读取且覆盖现有的 MPLAB X IDE 存储区。

确保代码不受代码保护。

*如果您收到因不正确范围引起的编程错误，确保范围未超过可用/剩余器件存储器的范围。

9.2.2 Debug Options
选择调试选项（适用于项目中的器件时）。

表 9-2. Debug Options 选项类别

Debug startup（调试启

动）

系统设置位于 Tools > Options > Embedded > Generic Settings（工具 > 选项 > 已安装工具 > 通用设

置）下，但可在此处进行更改：依次选择 Use system settings（使用系统设置），Run（运行），Halt
at main（在 main 处暂停），Halt at reset vector（在复位向量处暂停）。

Debug reset（调试复位） 系统设置位于 Tools > Options > Embedded > Generic Settings 下，但可在此处进行更改：依次选择

Use system settings，Main，ResetVector（复位向量）。

Use Software
Breakpoints

选中时可使用软件断点。
取消选中则使用硬件断点。请参见以下讨论，以确定哪种断点类型适合您的应用。

Use Simultaneous Debug
（使用同步调试）

选中时表示项目是多核同步调试会话的一部分。

表 9-3. 软件断点与硬件断点

特性 软件断点 硬件断点

断点数 无限 有限

断点写入到 程序存储器 调试寄存器

设置断点的时间 取决于振荡器速度，可能需要数分钟 极短

断点滑移（Skidding） 无 有

注：使用软件断点进行调试会影响器件的耐用性。因此，建议不要将以这种方式使用过的器件用作生产器

件。

9.2.3 Program Options
选择在编程前擦除整个存储器还是合并代码。

表 9-4. Program Options 选项类别

Erase All Before
Program

选中时可在编程开始前擦除整个存储器。
除非编程新器件或已擦除的器件，否则都必须选中此复选框。若未选中此复选框，将不对器件执行擦除操

作并且程序代码将与器件中已存在的代码合并。

Do not erase auxiliary
memory（不要擦除辅

助存储器）

对于支持辅助存储器的器件：

选中时不会在编程时擦除辅助存储器。

取消选中时会在编程时擦除辅助存储器。

9.2.4 ICD 5 Tool Options（ICD 5 工具选项）

设置 MPLAB ICD 5 特定选项。
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表 9-5. ICD 5 Tool Options 选项类别

Programming Mode Entry（编程模式进入） 选择编程模式进入类型：

• Use high voltage program mode entry（使用高电压编程模式进入）

• Use low voltage program mode entry（使用低电压编程模式进入）

PGC Configuration（PGC 配置） 编程时钟引脚设置。

• none（无）

• pull up（上拉）

• pull down（下拉）

PGC resistor value (kohms)（PGC 电阻值（kΩ）） 如果上面选择了 pull up 或 pull down，则输入 0-50 kΩ之间的电阻值。

PGD Configuration（PGD 配置） 编程数据引脚设置。

• none

• pull up

• pull down

PGD resistor value (kohms)（PGD 电阻值（kΩ）） 如果上面选择了 pull up 或 pull down，则输入 0-50 kΩ之间的电阻值。

9.2.5 Freeze Peripherals（冻结外设）

选择程序暂停时冻结或不冻结的外设。可用的选项取决于所选器件。

表 9-6. Freeze Peripherals 选项类别

Freeze Peripherals 选中时可在暂停时冻结所有外设。
取消选中时可取消冻结所有外设。

该选项适用于 PIC12/16/18 MCU。

Peripheral Freeze Enable（外设冻结使能） 选中时可选择要冻结的外设。
取消选中时可取消冻结所有外设。

该选项适用于 AC244066。

Peripheral List（外设列表） 选中时可在暂停时冻结外设。
取消选中时可取消冻结外设。

该选项适用于 16 位和 32 位 MCU。

PIC12/16/18 MCU 器件

要在暂停时冻结/取消冻结所有器件外设，请选中/取消选中“Freeze Peripherals”复选框。如果所需外设

并未暂停，请注意，某些外设没有暂停时冻结功能，因而无法受调试器控制。

dsPIC、PIC24 和 PIC32 器件

要在暂停时冻结/取消冻结某个外设，请从列表中选中/取消选中该外设。如果未在列表中看到某个外设，则

选中/取消选中“Freeze All Other Peripherals”（冻结所有其他外设）。如果所需外设并未暂停，请注

意，某些外设没有暂停时冻结功能，因而无法受调试器控制。

9.2.6 Trace and Profiling
根据为项目选择的器件，可以在调试时使用跟踪、PC 采样/性能分析或其他数据收集功能。请按照下面几

节所述使能并设置这些功能。

8 位和 16 位器件

此页面上的可用选项取决于项目中器件的跟踪/性能分析功能。
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表 9-7. Trace/Profiling 选项类别

Data Collection Selection 使能/禁止数据收集。

• Off（关闭）——不收集目标数据。

• User Instrumented Trace（用户插装跟踪）。

• PC Sampling（PC 采样）。

• Power Monitor (Target Power Sampling)（功率监视器（目标功率采样））。

Data File Path and Name（数

据文件的路径和名称）

输入或更改用于存储数据的文件的路径和/或名称。

• 输入文件名称（路径将是相对于项目而言的相对路径）——推荐。

• 输入路径和文件名称（路径将是绝对路径）。

• Browse (...)（浏览（...））到文件，选择“Absolute”（绝对），然后选择该文件并单击

Save（保存）（路径将是绝对路径）。

注：浏览到文件时不要选择“Relative”（相对），否则 MPLAB® X IDE 将无法找到该文件。运行

时，将收到路径不存在的警告消息。

Data File Maximum Size
(bytes)（数据文件的最大大小

（字节））

设置数据文件的最大大小。
目标功率采样每次采样占用 12 字节或 18 字节（含 PC 数据）。

可以根据选择的跟踪类型将文件大小调整为这些字节大小之一的倍数。其他跟踪数据类型可能使用
与上述字节大小不同的记录字节大小。

Data Buffer Maximum Size
(bytes)（数据缓冲区的最大大小

（字节））

设置数据缓冲区的大小，最大 54600 字节（调试器设备上）。

对于目标器件运行时在存储器中缓冲的跟踪/采样数据，各个跟踪或采样条目的大小根据跟踪/采样

类型和正在使用的器件和工具的不同而有所不同。通常，最好将此缓冲区设置得尽量大。

例如，带指令跟踪功能的增强型 PIC16 为每个存储器内条目使用 1 至 3 字节。每个条目还将生成

一个 13 字节的 ICD5 指令跟踪条目。通常，每个这样的存储器内记录都将转换为跟踪数据文件条

目行，数据文件大小说明中对此进行了详细介绍（见跟踪/采样文件条目大小的数据文件大小说

明）。

Stall CPU When Trace Buffer is
Full（跟踪缓冲区已满时暂停
CPU）

跟踪缓冲区已满时停止执行。在上述选项中设置缓冲区大小。

User Instrumented Trace 选项

Disable Trace Macros（禁止跟

踪宏）

选中时可暂时禁止跟踪宏，取消选中时可使能跟踪宏。

要禁止跟踪，删除所有宏并在“Data Collection Selection”下选择“Off”。

Communications Medium（通

信介质）

如果可用，从以下项（取决于器件）中选择跟踪介质：Native（本机）、I/O Port（I/O 端口）和

SPI。

I/O Port Selection（I/O 端口选

择）

指定用于 I/O 端口跟踪的器件端口。

将列出所选器件的可用组合。

SPI Selection（SPI 选择） 指定用于 SPI 跟踪的器件 SPI 引脚。将列出所选器件的可用引脚。

PC Sampling 选项

Timer Selection（定时器选择）

（未被应用程序代码使用）

选择用于计数 PC 采样的器件定时器。

注：应用程序中将无法再使用此定时器，它将专用于 PC 采样。

注：只能选择一个定时器；不能通过组合两个定时器构成 32 位定时器。使用 32 位定时器对的其

中一个定时器时，无法将该定时器对作为 32 位定时器使用。

Timer Interrupt Priority（定时

器中断优先级）

选择定时器的中断优先级。
注：所选优先级应高于应用程序中设置的其他优先级。否则，其他优先级将比采样优先级高，您将

无法捕捉这些采样。

Timer Interval（定时器时间间

隔）

输入采样间隔。
该值必须是整数值（1、2 和 3 等）。

如果您未捕捉数据，则可能丢失采样（鉴于当前的时间间隔）。请尝试调整单位选择和间隔，例

如，如果之前为 1 毫秒，尝试改为 990 微秒。
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Timer Interval Units（定时器时

间间隔单位）

选择采样间隔单位：

• microseconds（微秒）

• milliseconds（毫秒）

• seconds（秒）

• instruction cycles（指令周期）

32 位器件

此页面上的可用选项取决于项目中器件的跟踪/性能分析功能。

表 9-8. Trace/Profiling 选项类别

Data Collection
Selection

使能/禁止数据收集。

• Off——不收集目标数据。

• Instruction Trace/Profiling。

• User Instrumented Trace。

• Power Monitor (Target Power Sampling)。

Data File Path and
Name

输入或更改用于存储数据的文件的路径和/或名称。

• 输入文件名称（路径将是相对于项目而言的相对路径）——推荐。

• 输入路径和文件名称（路径将是绝对路径）。

• Browse (...)到文件，选择“Absolute”，然后选择该文件并单击 Save（路径将是绝对路径）。

注：浏览到文件时不要选择“Relative”，否则 MPLAB® X IDE 将无法找到该文件。运行时，将收到路径不

存在的警告消息。

Data File Maximum
Size (bytes)

设置数据文件的最大大小。
使用调试器时，跟踪数据文件中指令跟踪数据的每一行都需要 13 字节。

目标功率采样每次采样占用 12 字节或 18 字节（含 PC 数据）。

可以根据选择的跟踪类型将文件大小调整为这些字节大小之一的倍数。其他跟踪数据类型可能使用与上述字
节大小不同的记录字节大小。

Data Buffer
Maximum Size (bytes)

设置数据缓冲区的大小，最大 54600 字节（调试器设备上）。

对于目标器件运行时在存储器中缓冲的跟踪/采样数据，各个跟踪或采样条目的大小根据跟踪/采样类型和正

在使用的器件和工具的不同而有所不同。通常，最好将此缓冲区设置得尽量大。

例如，PIC32 指令跟踪每“帧”占用 8 字节，这可在跟踪文件中产生超过 50 个 13 字节的 ICD 5 指令跟踪

条目。

User Instrumented Trace 选项

Disable Trace Macros 选中时可暂时禁止跟踪宏，取消选中时可使能跟踪宏。

要禁止跟踪，删除所有宏并在“Data Collection Selection”下选择“Off”。

Communications
Medium

如果可用，从以下项（取决于器件）中选择跟踪介质：Native

9.2.7 Power
选择是否通过调试器为目标板供电。

表 9-9. Power 选项类别

Power Target Circuit from ICD 5（通过 ICD 5 为目标电路

供电）

选中时通过调试器供电。
取消选中时通过其自身电源为目标板供电。

Voltage Level（电压大小） 如果选中上述选项，则可选择调试器提供的目标 Vdd（2.375V-5.5V）。

9.2.8 Clock
在此选项类别下输入运行时时钟（指令）速度。这并不会设置速度，只是将其值告知调试器以进行运行时

观察、数据捕捉和跟踪。
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表 9-10. Clock 选项类别

Use FRC in Debug mode
(dsPIC33E/F and PIC24E/F/H devices only)（在调试模式下使用

FRC（仅限 dsPIC33E/F 和 PIC24E/F/H 器件））

调试时，使用器件内部快速 RC（FRC）而不是为应用指定的振荡

器来提供时钟。这在应用时钟较慢时十分有用。
选中此复选框将使应用以低速运行，但以更快的 FRC 速度进行调

试。

更改此设置后重新编程。

注：在调试时，未冻结的外设将以 FRC 速度运行。

Target run-time instruction speed（目标运行时指令速度） 为所选的“速度单位”输入一个值。
例 1：对于 PIC24 MCU 和 32 MHz（HS）的目标时钟振荡器，指

令速度 = 32 MHz/2 = 16 MIPS。

例 2：对于 PIC18F8722 MCU 和采用 PLL 的 10 MHz（HS）目标

时钟振荡器（x4 = 40 MHz），指令速度 = 40 MHz/4 = 10
MIPS。

Instruction speed units（指令速度单位） 选择下列一个单位：

KIPS——每秒千（103）条指令

MIPS——每秒百万（106）条指令

9.2.9 Communication（通信）

设置适用于您的器件和目标通信类型的选项。

表 9-11. Communication 选项类别

Interface（接口） 根据项目中的器件从可用选项中选择接口。

Speed (MHz)（速度（MHz）） 根据接口适用的速度范围输入速度。

High Voltage Activation Mode（高电压激

活模式）

该选项仅针对具有该选项的 AVR®器件显示。No High Voltage（无高电压）——默认

设置。 Simple High Voltage Pulse（简单高电压脉冲）——该工具将尝试通过发出高

电压脉冲来激活接口。如果引脚配置为输入，则该过程是安全的。 User Power
Toggle（用户电源重启）——在该模式下，系统将提示用户重启目标板的电源。一旦工

具检测到电源恢复，它将在配置目标器件引脚之前发出高电压脉冲，从而使激活过程尽

可能平稳。 另请参见 UPDI 高电压激活信息。

9.2.9.1 用户电源重启设计注意事项
使用调试器时，如果目标 Vdd 上的电源切换上升时间太长（大于 10 秒），用户电源重启功能将不起作

用。例如，对于 STK600，使用电源开关时的上升时间会太长，但使用 VTARGET 跳线时的上升时间则足够

短。

如果开发人员自行设计电路板，应确保 Vdd 上升时间小于 10 秒。

9.2.9.2 使用 UPDI 对 AVR 器件进行编程
MPLAB ICD 5 支持使用高电压机制激活 AVR 统一编程和调试接口（UPDI）。在具有 UPDI 的低引脚数

AVR 器件上，可通过配置 RSTPINCFG 配置位将 UPDI 引脚配置为 GPIO 或 RESET 。为了进行进一步的编

程，调试器将必须使用高电压脉冲来重新激活 UPDI 接口。使用高电压脉冲时，必须确保连接到 UPDI 线的

所有电路都可以承受至少 12V 的脉冲。

GPIO 与 UPDI 操作的区别：

当使用高压脉冲重新激活 UPDI 接口时，重新激活只是暂时的，但是它将保持 UPDI 功能直到下一次复位。

下一次复位之后，引脚将返回到 RSTPINCFG 配置位指定的配置。要在复位后将引脚配置为 UPDI，用户必

须将 RSTPINCFG 配置位更改回 UPDI。

将 RSTPINCFG 配置为 GPIO 时，可以执行调试会话，但引脚将临时配置为 UPDI，并且不能用作 GPIO 引

脚。

https://microchipdeveloper.com/mplabx:avr-updi-info
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表 9-12. SYSCFG0 RSTPINCFG[1:0]配置位

值 功能

0x0 GPIO
0x1 UPDI
0x2 RESET
0x3 保留

9.2.10 Tool Pack Selection（工具包选择）

选择使用最新工具包或其他版本来支持项目中的器件。

表 9-13. Tool Pack Selection 选项类别

Tool pack update options（工

具包更新选项）

Use latest installed tool pack (recommended)（使用最新安装的工具包（推荐））——使用最新

安装的工具包版本。
Use specific tool pack（使用特定工具包）——从其他可用工具包版本的列表中选择。

Specifically selected version
（专门选择的版本）

单击此处，将弹出一个对话框，其中包含要选择的工具包版本的列表。

9.3 调试器窗口和对话框
以下主题给出的窗口和对话框专门用于调试器或其他相关调试工具。

9.3.1 跟踪窗口和相关对话框
跟踪窗口显示跟踪的结果。此窗口可用于调试器和软件模拟器。

图 9-2. 跟踪窗口

右键单击上面显示的窗口中的某一列会弹出带有功能列表的菜单。关于这些功能的更多信息，请参见

MPLAB X IDE 用户指南/帮助文件中“MPLAB X IDE Windows and Dialogs”（MPLAB X IDE 窗口和对话

框）下的“Trace Window”（Trace 窗口）。

9.3.2 ITM 窗口和相关对话框

SAM ITM 跟踪将生成 UART 格式的数据，支持在最多 32 个端口上进行 printf样式的调试。
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图 9-3. ITM 显示
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图 9-4. ITM Select Ports（选择端口）对话框

相关信息

Arm ITM/SWO 跟踪
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10. 硬件规范
本章详述了 MPLAB ICD 5 设备和相关硬件。

10.1 调试器设备
MPLAB ICD 5 在线调试器设备的评级如下：

• 在实验室环境中为 A 类设备。

• 在家庭或办公环境中为 C 类设备。

• 工作温度：0°C-70°C。

10.2 电源规范
可通过以下连接为设备供电：

• 以太网连接（使用以太网供电（PoE））。该连接还能够以最高 1A 的电流为目标板供电。

• USB-C 连接。该连接也能够为目标板供电，但具体电流取决于 PC 主机，连接调试器后即可确定。如果

可提供的电流小于 3A，MPLAB X IDE 将提醒用户无法为目标板提供全额供电（3A）。

相关信息

供电和自检

10.3 指示灯（LED）
MPLAB ICD 5 设备顶部有两个相互对接的灯管，每个灯管由一个 LED 点亮。

调试器预期的启动序列如下：

1. 紫色——常亮约 3 秒钟。

2. 蓝色——当调试器运行上电自检时，闪烁约 2 秒钟。

3. 蓝色——常亮。调试器就绪。

下表给出了用于读取指示灯的参考信息。

表 10-1. LED 和自举程序错误说明

LED 1 LED 2 说明

正常模式

蓝色 蓝色 电源已连接；调试器处于待机状态；网络

已准备好进行连接

白色 蓝色 网络已连接

白色，慢速闪烁 蓝色 MPLAB X IDE/MPLAB IPE 已通过网络启动

与 ICD 5 的通信

红色 蓝色 网络连接失败/错误

黄色 蓝色 已选中 Power target circuit from ICD 5
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...........（续）
LED 1 LED 2 说明

绿色 蓝色 未选中 Power target circuit from ICD 5

绿色，慢速闪烁 蓝色 DGI 已连接

紫色 紫色 自举程序正在运行

黄色 黄色 调试器忙

红色 红色 操作失败

自举程序错误

紫色 红色，慢速闪烁 访问调试器的串行 EEPROM 时出错

紫色 红色，快速闪烁 无法处理自举程序 API 命令

白色，快速闪烁 白色，快速闪烁 工具固件中出现运行时异常

10.4 PC 连接规范
MPLAB® ICD 5 在线调试器可使用以下连接类型之一与 PC（和 MPLAB X IDE/MPLAB IPE）连接。表中还

列出了连接速度。

连接类型 连接详细信息 编程和调试 跟踪

USB Type-C®（默认） HS USB 2.0 USB 2.0
最高 480 Mbps

以太网 直接或通过网络 最高 100 Mbps 不支持

以下章节将介绍 MPLAB ICD 5 设备上用于通信的连接器。

10.4.1 USB Type-C®连接器（J1）和线缆

USB Type-C 连接器和线缆用于调试器与计算机之间的 USB 2.0 通信。建议使用工具包随附的线缆，以避免

发生通信问题。

10.4.2 以太网连接器（J6）和线缆

8 引脚 RJ-45 型连接器和标准以太网 CAT5e/CAT6 线缆可用于 MPLAB ICD 5 设备与 PC（和 MPLAB X IDE/
MPLAB IPE）之间的以太网通信。该连接器有两个指示 LAN 活动的内置 LED。没有水晶头保护套的以太网

线缆最适合该连接器。

注：MPLAB ICD 5 工具包不随附以太网线缆。
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图 10-1. MPLAB® ICD 5 上的以太网连接器

表 10-2. 以太网连接器引脚分配

引脚编号 功能

1 TX+

2 TX-

3 RX+

4 EGND

5 EGND

6 RX-

7 EGND

8 EGND

EGND：外壳地

表 10-3. 连接器 LED
LED 位置 LED 颜色 LED 功能

左上方 绿色 LAN ACT

右上方 黄色 LAN LINK

10.5 8 引脚通信硬件
要使调试器与目标板之间进行完整通信，应将随附的 RJ-45 线缆一端插入调试器上的模块化 RJ-45 插孔，另

一端连接到目标板上的 RJ-45 模块化连接器。此外，还可以将该线缆插入调试器适配器板进行许多器件传

统连接。有关详细信息，请参见 3.3 目标板连接。

有关 8 引脚 RJ-45 模块化连接器和模块化线缆的详细信息，请参见以下章节。

10.5.1 模块化连接器——RJ-45
ICD 工具使用 RJ-45 模块化连接器和线缆与目标板进行通信。

模块化连接器引脚始终按照相同的顺序编号，与连接器朝向无关。
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图 10-2. 模块化连接器——RJ-45

表 10-4. 模块化连接器朝向

RJ-45 插孔（在 ICD 工具上） RJ-45*连接器（在目标板上）

* 有关在目标板上连接 RJ-11 线缆的信息，请参见将 RJ-11 型线缆连接到调试器上的 RJ-45 插孔。

引脚编号如下图所示。尽管工具和目标板上的连接器朝向不同，但就连接器本身而言，引脚 1 始终为引脚

1。
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图 10-3. 模块化连接器

10.5.2 模块化线缆——RJ-45
ICD 工具使用 RJ-45 模块化连接器和线缆与目标板进行通信。

模块化线缆插头引脚始终按照相同的顺序编号，与插头朝向无关。

图 10-4. 模块化（RJ-45）线缆透明插头

线缆按照插头视图（见下图）进行反向接线。
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图 10-5. 线缆反向接线

引脚编号如下图所示。尽管插头在插入工具和目标板时的朝向不同，但就插头本身而言，引脚 1 始终为引

脚 1。

图 10-6. 模块化连接器和线缆

10.6 通信硬件
要使调试器与目标板之间进行标准通信，应使用具有 RJ-11 连接器的适配器。

10.6.1 将 RJ-11 型线缆连接到调试器上的 RJ-45 插孔

MPLAB ICD 5 在线调试器具有用于与目标板通信的 RJ-45 连接器。RJ-11 型线缆与 RJ-45 连接器的连接方式

很简单，只需将 RJ-11 型线缆插入 RJ-45 连接器的中心即可。

有关此连接的引脚分配，请参见下图。
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图 10-7. RJ-45 插孔与 RJ-11 连接器的引脚分配

引脚 RJ-45 功能 引脚 RJ-11

1 TMS EJTAG 测试模式选择

2 保留 1

3 PGC（ICSPCLK） 标准通信时钟/TCK
（JTAG 测试时钟）

2 PGC（ICSPCLK）

4 PGD（ICSPDAT） 标准通信数据/TDO
（JTAG 测试数据输出）

3 PGD（ICSPDAT）

5 GND 地 4 GND

6 VDD_TGT 目标板上的电源 5 VDD_TGT

7 VPP 电源 6 VPP

8 TDI JTAG 测试数据输入

10.6.2 标准通信
调试器与目标处理器的主接口采用标准通信方式。它包含与高电压（VPP）线和 VDD 检测线的连接，以及编

程和连接目标器件所需的时钟和数据连接。

VPP 高电压线可生成电压范围为 0V 至 14V 的可变电压，以满足特定仿真处理器的电压要求。

VDD 检测连接从目标处理器汲取极少的电流。实际功率来自 MPLAB ICD 5 在线调试器系统，因为 VDD 检测

线仅用作参考来跟踪目标电压。VDD 连接通过光电开关隔离。

时钟和数据连接是具有以下特性的接口：

• 时钟和数据信号为高阻模式（即使在未向 MPLAB ICD 5 在线调试器系统供电时也是如此）。

• 时钟和数据信号不受因故障目标系统或不当连接引起的高电压的影响。

• 时钟和数据信号不受因故障目标系统中出现短路而引起的大电流的影响。

图 10-8. 6 引脚标准引脚分配

1

2

3

4

5

6

Pin Name Function

1 VPP Power

2 VDD_TGT Power on target

3 GND Ground

4 PGD (ICSPDAT) Standard Com Data

5 PGC (ICSPCLK) Standard Com Clock

6 - Reserved

Bottom of

Standard Socket

Target Board
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表 10-5. 电气逻辑表

逻辑输入 VIH = VDD x 0.7V（最小值）

VIL = VDD x 0.3V（最大值）

逻辑输出 VDD = 5V VDD = 3V VDD = 2.3V VDD = 1.65V

VOH = 3.8V（最小值） VOH = 2.4V（最小值） VOH = 1.9V（最小值） VOH = 1.2V（最小值）

VOL = 0.55V（最大值） VOL = 0.55V（最大值） VOL = 0.3V（最大值） VOL = 0.45V（最大值）

10.6.3 模块化线缆和连接器
标准通信使用模块化线缆连接调试器和目标应用。下面列出了有关此线缆及其连接器的规范。

10.6.3.1 模块化连接器规范
• 制造商，部件编号——AMP Incorporated，555165-1

• 分销商，部件编号——Digi-Key，A9031ND

下表显示了某个应用中的模块化连接器引脚与单片机引脚的对应关系。这种配置提供了全部的在线调试器
功能。

图 10-9. 目标板的模块化连接器引脚分配

Modular 
Connector Pin

Microcontroller 
Pin

6 Reserved

5 RB6

4 RB7

3 Ground

2 VDD Target

1 VPP 1
6

Bottom View of Modular Connector 
Pinout on Target Board

1 6

Front View of Modular 
Connector on Target Board

10.6.3.2 模块化插头规范
• 制造商，部件编号——AMP Incorporated，5-554710-3

• 分销商，部件编号——Digi-Key，A9117ND

10.6.3.3 模块化线缆规范
制造商，部件编号——Microchip Technology，07-00024。此线缆的长度（L）为 6 英寸。建议您不要使

用长度超过 6 英寸的模块化线缆，以避免潜在的通信问题。
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图 10-10. 模块化线缆

Pin 1

L

Pin 6

6 inches

10.7 恢复规范
MPLAB ICD 5 设备可通过器件复位和闪存擦除两种方法置于恢复模式。将回形针或类似工具插入设备底部

的孔来激活硬件复位开关（见下图）。

此外，还可以使用硬件工具紧急引导固件恢复中的软件将设备置于恢复模式。

图 10-11. 恢复开关的位置

10.8 目标板注意事项
应根据所选器件和应用的要求向目标板供电。

如果器件的工作条件超过器件数据手册“电气特性”一章中的“绝对最大值”，可能对器件造成永久性损

坏。上述值仅代表本规范规定的极限工作条件，不代表器件在上述极限值或超出极限值的情况下仍可正常

工作。器件长时间工作在最大值条件下，其可靠性可能受到影响。

调试器检测目标电压。VDD_TGT 上有 182 kΩ的负载。

根据调试器与目标板之间使用的通信类型，目标板电路有以下注意事项：

• 目标板连接电路

• 阻止调试器正常工作的电路
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11. 版本历史

11.1 版本 A（2023 年 5 月）
本文档的初始版本。

11.2 版本 B（2023 年 11 月）
• 关于调试器 > 组件章节增补了以下内容：

– 兼容的 USB 隔离器

– ICD 5 工具箱组件的图片

– 工具包附件的说明

• 在初始版本的基础之上通篇增补了公开发布内容。

11.3 版本 C（2024 年 7 月）
• 连接 > PC 连接 > 以太网模式章节增补了以下内容。

– 新增小节介绍 APIPA

• 连接 > 目标板连接 > 适配器板引脚分配章节增补了以下内容。

– 更新了引脚分配图

• 新增图片以演示 PoE 和以太网连接。
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12. 支持
有关支持问题，请参见以下章节。

12.1 保修登记
请访问 www.microchip.com/mysoftware 在线注册工具。如果您尚未拥有 myMicrochip 帐户，可以单击

该链接进行注册。如果您已经拥有一个帐户，请登录并单击 Register Hardware Tool（注册硬件工

具）。

在线注册工具后，您便可以收到新产品更新信息。可在 Microchip 网站上获得临时软件版本。

12.2 myMicrochip 个性化通知服务
Microchip 的个性化通知服务有助于客户了解关于所关注 Microchip 产品的最新信息。注册客户可在指定

产品系列或开发工具发生变更、更新、发布新版本或勘误表时，收到电子邮件通知。

如需注册并选择接收个性化通知的首选项，请转至：

www.microchip.com/pcn

该网页提供 FAQ 和注册详细信息。

http://www.microchip.com/mysoftware
https://www.microchip.com/pcn
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Microchip 信息

Microchip 网站
Microchip 网站（www.microchip.com）为客户提供在线支持。客户可通过该网站方便地获取文件和信

息。我们的网站提供以下内容：

• 产品支持——数据手册和勘误表、应用笔记和示例程序、设计资源、用户指南以及硬件支持文档、最新
的软件版本以及归档软件

• 一般技术支持——常见问题解答（FAQ）、技术支持请求、在线讨论组以及 Microchip 设计伙伴计划成

员名单

• Microchip 业务——产品选型和订购指南、最新 Microchip 新闻稿、研讨会和活动安排表、Microchip
销售办事处、代理商以及工厂代表列表

产品变更通知服务
Microchip 的产品变更通知服务有助于客户了解 Microchip 产品的最新信息。注册客户可在他们感兴趣的

某个产品系列或开发工具发生变更、更新、发布新版本或勘误表时，收到电子邮件通知。

欲注册，请访问 www.microchip.com/pcn，然后按照注册说明进行操作。

客户支持
Microchip 产品的用户可通过以下渠道获得帮助：

• 代理商或代表

• 当地销售办事处

• 应用工程师（ESE）

• 技术支持

客户应联系其代理商、代表或 ESE 寻求支持。当地销售办事处也可为客户提供帮助。本文档后附有销售办

事处的联系方式。

也可通过 www.microchip.com/support 获得网上技术支持。

Microchip 器件代码保护功能
请注意以下有关 Microchip 产品代码保护功能的要点：

• Microchip 的产品均达到 Microchip 数据手册中所述的技术规范。

• Microchip 确信：在正常使用且符合工作规范的情况下，Microchip 系列产品非常安全。

• Microchip 注重并积极保护其知识产权。严禁任何试图破坏 Microchip 产品代码保护功能的行为，这种

行为可能会违反《数字千年版权法案》（Digital Millennium Copyright Act）。

• Microchip 或任何其他半导体厂商均无法保证其代码的安全性。代码保护并不意味着我们保证产品是

“牢不可破”的。代码保护功能处于持续发展中。Microchip 承诺将不断改进产品的代码保护功能。

法律声明
提供本文档的中文版本仅为了便于理解。请勿忽视文档中包含的英文部分，因为其中提供了有关

Microchip 产品性能和使用情况的有用信息。Microchip Technology Inc.及其分公司和相关公司、各级主

管与员工及事务代理机构对译文中可能存在的任何差错不承担任何责任。建议参考 Microchip Technology
Inc.的英文原版文档。

本出版物及其提供的信息仅适用于 Microchip 产品，包括设计、测试以及将 Microchip 产品集成到您的应

用中。以其他任何方式使用这些信息都将被视为违反条款。本出版物中的器件应用信息仅为您提供便利，

将来可能会发生更新。如需额外的支持，请联系当地的 Microchip 销售办事处，或访问

www.microchip.com/en-us/support/design-help/client-support-services。

https://www.microchip.com
https://www.microchip.com/pcn
https://www.microchip.com/support
https://www.microchip.com/en-us/support/design-help/client-support-services
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Microchip“按原样”提供这些信息。Microchip 对这些信息不作任何明示或暗示、书面或口头、法定或其

他形式的声明或担保，包括但不限于针对非侵权性、适销性和特定用途的适用性的暗示担保，或针对其使

用情况、质量或性能的担保。

在任何情况下，对于因这些信息或使用这些信息而产生的任何间接的、特殊的、惩罚性的、偶然的或间接

的损失、损害或任何类型的开销，Microchip 概不承担任何责任，即使 Microchip 已被告知可能发生损害

或损害可以预见。在法律允许的最大范围内，对于因这些信息或使用这些信息而产生的所有索赔，

Microchip 在任何情况下所承担的全部责任均不超出您为获得这些信息向 Microchip 直接支付的金额（如

有）。如果将 Microchip 器件用于生命维持和/或生命安全应用，一切风险由买方自负。买方同意在由此引

发任何一切损害、索赔、诉讼或费用时，会维护和保障 Microchip 免于承担法律责任。除非另外声明，在

Microchip 知识产权保护下，不得暗中或以其他方式转让任何许可证。

商标
Microchip 的名称和徽标组合、Microchip 徽标、Adaptec、AVR、AVR 徽标、AVR Freaks、BesTime、
BitCloud、CryptoMemory、CryptoRF、dsPIC、flexPWR、HELDO、IGLOO、JukeBlox、KeeLoq、
Kleer、LANCheck、LinkMD、maXStylus、maXTouch、MediaLB、megaAVR、Microsemi、Microsemi
徽标、MOST、MOST 徽标、MPLAB、OptoLyzer、PIC、picoPower、PICSTART、PIC32 徽标、

PolarFire、Prochip Designer、QTouch、SAM-BA、SenGenuity、SpyNIC、SST、SST 徽标、

SuperFlash、Symmetricom、SyncServer、Tachyon、TimeSource、tinyAVR、UNI/O、Vectron 及

XMEGA 均为 Microchip Technology Incorporated 在美国和其他国家或地区的注册商标。

AgileSwitch、ClockWorks、The Embedded Control Solutions Company、EtherSynch、Flashtec、
Hyper Speed Control、HyperLight Load、Libero、motorBench、mTouch、Powermite 3、Precision
Edge、ProASIC、ProASIC Plus、ProASIC Plus 徽标、Quiet-Wire、SmartFusion、SyncWorld、
TimeCesium、TimeHub、TimePictra、TimeProvider 和 ZL 均为 Microchip Technology Incorporated
在美国的注册商标。

Adjacent Key Suppression、AKS、Analog-for-the-Digital Age、Any Capacitor、AnyIn、AnyOut、
Augmented Switching、BlueSky、BodyCom、Clockstudio、CodeGuard、CryptoAuthentication、
CryptoAutomotive、CryptoCompanion、CryptoController、dsPICDEM、dsPICDEM.net、Dynamic
Average Matching、DAM、ECAN、Espresso T1S、EtherGREEN、EyeOpen、GridTime、
IdealBridge、IGaT、In-Circuit Serial Programming、ICSP、INICnet、Intelligent Paralleling、
IntelliMOS、Inter-Chip Connectivity、JitterBlocker、Knob-on-Display、MarginLink、maxCrypto、
maxView、memBrain、Mindi、MiWi、MPASM、MPF、MPLAB Certified徽标、MPLIB、MPLINK、
mSiC、MultiTRAK、NetDetach、Omniscient Code Generation、PICDEM、PICDEM.net、PICkit、
PICtail、Power MOS IV、Power MOS 7、PowerSmart、PureSilicon、QMatrix、REAL ICE、Ripple
Blocker、RTAX、RTG4、SAM-ICE、Serial Quad I/O、simpleMAP、SimpliPHY、SmartBuffer、
SmartHLS、SMART-I.S.、storClad、SQI、SuperSwitcher、SuperSwitcher II、Switchtec、
SynchroPHY、Total Endurance、Trusted Time、TSHARC、Turing、USBCheck、VariSense、
VectorBlox、VeriPHY、ViewSpan、WiperLock、XpressConnect 和 ZENA 均为 Microchip Technology
Incorporated 在美国和其他国家或地区的商标。

SQTP 为 Microchip Technology Incorporated 在美国的服务标记。

Adaptec 徽标、Frequency on Demand、Silicon Storage Technology 和 Symmcom 均为 Microchip
Technology Inc.在除美国外的国家或地区的注册商标。

GestIC 为 Microchip Technology Inc.的子公司 Microchip Technology Germany II GmbH & Co. KG 在除

美国外的国家或地区的注册商标。

在此提及的所有其他商标均为各持有公司所有。

© 2024, Microchip Technology Incorporated 及其子公司版权所有。

AMBA、Arm、Arm7、Arm7TDMI、Arm9、Arm11、Artisan、big.LITTLE、Cordio、CoreLink、
CoreSight、Cortex、DesignStart、DynamIQ、Jazelle、Keil、Mali、Mbed、Mbed Enabled、NEON、
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POP、RealView、SecurCore、Socrates、Thumb、TrustZone、ULINK、ULINK2、ULINK-ME、ULINK-
PLUS、ULINKpro、µVision 和 Versatile 是 Arm Limited（或其子公司）在美国和/或其他国家/地区的商

标或注册商标。

ISBN： 978-1-6683-4981-6

质量管理体系
有关 Microchip 质量管理体系的信息，请访问 www.microchip.com/quality。

https://www.microchip.com/quality
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美洲 亚太地区 亚太地区 欧洲

公司总部

2355 West Chandler Blvd.
Chandler, AZ 85224-6199
电话：480-792-7200
传真：480-792-7277

技术支持：

www.microchip.com/support

网址：

www.microchip.com
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